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Acronyms 
 
ACH  Automated Clearing House 
ADMIN  Administration 
AFSRB  APHIS Financial Systems & Reporting Branch 
AP   Account Payable 
APHIS  Animal and Plant Health Inspection Service 
AR  Accounts Receivable 
AVC  Availability Control 
BESB  Budget Execution Support Branch (part of FMD, Riverdale) 
BI  Business Intelligence 
BOC  Budget Object Code 
BOBJ  Business Objects 
BP  Budget Period 
BT   Billings Team 
CM  Cost Management 
CR  Change Request 
DOC  Document 
DPR  Down Payment Request 
DP  Down Payment 
ECC  ERP (Enterprise resource planning) Central Component 
FIFO  First in first out 
FM   Funds Management  
FMD  Financial Management Division 
FMMI  Financial Management Modernization Initiative  
FN  Foreign National  
FOB  Financial Operations Branch (part of FMD, Minneapolis) 
FOST  Financial Operations Services Team (used to be part of APT before it split) 
GL  General Ledger 
GSA  General Services Agency 
HANA  High Performance Analytical Appliance 
IAS  Integrated Acquisition System 
INTR  Intra-USDA Reimbursable 
IOAT  International Operations & Accounting Team (used to be part of APT before it split) 
IPAC  Intra-Governmental Payment and Collection System 
LIACR  Line Items – Actual Costs/Revenues 
MPLS  Minneapolis 
MRP  Marketing and Regulatory Programs 
MRPBS  Marketing and Regulatory Programs Business Services 
NFC  National Finance Center (part of USDA, New Orleans)  
OCFO  Office of the Chief Financial Officer (part of USDA, New Orleans)  
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OH  Overhead 
OMB  Office of Management & Budget 
OTC  Over the Counter 
PROP  Property System 
RONA  Reimbursable Order No Advance 
ROR  Reimbursable Order Report 
ROWA  Reimbursable Order With Advance 
ROWE  Reimbursable Order With Exception 
RRB  Resource Related Billing  
SF  Standard Form 
SHC  Short Hand Code 
SO  Sales Order 
SOF PTD Status of Funds, Project to Date 
SPS  Secure Payment System 
SWIFT  Society for Worldwide Interbank Financial Telecommunication 
TAS  Treasury Account Symbol 
TAFS  Treasury Appropriation Fund Symbol 
TF  Trust Fund 
TOWA  Trust Order With Advance 
ULO  Un-Liquidated Obligation  
USDA  United States Department of Agriculture 
VS  Veterinary Services 
WBS  Work Breakdown Structure 
WS  Wildlife Services 
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Master Data Overview 
 

FMMI Master Data Elements 
 
Budget Period         4 characters 
Application of Funds       6-8 characters 
Fund          10 characters  
Fund/Cost Center        10 characters  
WBS Element/Funded Program       APHIS up to 18 characters  
Functional Area        16 characters 
Short Hand Code        27 characters 
Commitment Item (BOC) or Revenue Source Code (RSC)    4 characters 
 
Budget Period (BP) 
The BP indicates both the beginning and ending budget fiscal years for a fund. Each budget fiscal year 
begins October 1st and ends September 30th. Budget periods can be annual, multi-year or no-year. 
 
Example 
 Annual  2020 
 No-Year 20XX 
 Multi-year 1819 

 
Application of Funds 
The Application of Funds used in FMMI is the equivalent of the String Treasury Accounting Symbol (TAS).  
Each Application of Funds is tied to one or more FMMI Funds. 
 
Examples of Application of Funds: 
 12_1600 - Salaries and Expenses, APHIS 
 12X1600 - Salaries and Expenses, APHIS 
 12X1601 - Buildings and Facilities, APHIS 
 12X5161 - Agricultural Quarantine Inspection User Fee Account, APHIS 
 12X8226 – Miscellaneous Contributed Funds (Trust Funds), APHIS 

 
Link to Treasury Account Symbols: 
http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm 
 
Funds 
Funds in FMMI are used to represent the type of funding and its funding source.  Using the Fund and 
Budget Period together indicates the availability of funding as it pertains to time (no year, annual funds, 
multi-year funds).  It includes the specific attributes indicating the type of funding; e.g., direct, trust, 
special, or reimbursable.  A complete list of APHIS Funds is maintained in the BAM, Chapter 5, Exhibit 2. 
 

http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm
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OMB Recognized Category Programs 
 Cat A – Defined by Time – Quarterly Apportionments 
 Cat B – Project Specific – Apportionments other than quarterly 

 
Examples of Funds: 
 AP001600AD – General Direct-Cat A 
 AP001600AR – General Reimbursable-Cat A 
 AP0016IEAR – Import/Export User Fees; General-Reimb-Cat A 
 AP005161AV – Special AQI-Cat A  
 AP00160MBN – Farm Bill; Non-Appropriated-Transfer-Cat B  
 

Fund/Cost Centers 
Fund/Cost Centers are organizational elements that identify where the costs are incurred for performing 
activities within APHIS, generally representing staff and location.  A Fund/Cost center should not be used 
for tracking a project or functional area.  That can be accomplished with the combination of master data 
at time of obligation. 
 Fund Centers and Cost Centers have a one to one relationship. Cost Centers reside in the 

Controlling Module (i.e., Cost Management) while Fund Centers reside in the Funds 
Management Module. 

 Fund/Cost Centers reflect the level at which a Division spends at a location. 
 
Examples of Fund/Cost Centers 
 APWSHQ0024 – WS Headquarters, Maryland 
 APWSER0037 – WS Eastern Region Office – North Carolina 
 APWSRC0008 – HQ National Wildlife Research Center 
 APWSWR0008 – WS Western Region Office - Colorado 

 
Functional Areas 
APHIS functional areas should reflect the specific line items from our Appropriation Language received 
each year, or indicate the type of funding that is being received, such as AQI User Fees, and Non-AQI 
User Fees.  A complete list of Functional Areas is maintained in the BAM, Chapter 5, Exhibit 4. 
 
Examples of Functional Areas 
 AP00AGDISTRIB000 – APHIS Distributable- Cat A (00) 
 AP00AGREIMBUR000 – Reimbursable Agreements – Cat A (00) 
 AP02SUFB10201000 – Farm Bill-Plant Pest/Dis Mgmt – Cat B (01, 02 or 03) 
 AP01GPCITGREN000 – Citrus Greening - Cat B (01, 02 or 03) 

 
Funded Program/Work Breakdown Structure (WBS) 
 Provides a means of collection and tracking costs of a specific job, service, project, or task.  
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 WBS Elements should be thought of as a program or project with an operational purpose and a 
defined timeframe. These should be created when it is not possible to track costs using 
Functional Area, Cost Center, and Budget Object Code.  

 WBS Elements (Cost Management Module) have a one-to-one relationship with Funded 
Programs (Funds Management Module).  This helps to provide consistency between the Cost 
Management and Funds Management modules in FMMI.  

   
 
 
APHIS uses up to 3 WBS level: 
 Level 1 – AP.XX.XXX   
 Level 2 – AP.XX.XXX.XX  Spending occurs at level 2 or higher 
 Level 3 – AP.XX.XXX.XX.XXXX 

 
WBS Expense Project (AP.EX.XXXX.XX) 
 WBS elements for expense projects can be mapped to multiple cost centers. 

 
WBS Reimbursable (AP.RA.XXXX.XX) 
 WBS elements for reimbursable/trust projects can only be mapped to one cost center. 

 
Shorthand Code (SHC) 
The Shorthand Code (SHC) is a way to shorten the length of accounting information that gets sent into 
FMMI by feeder systems.   
 
Shorthand Code Format: 
 Budget Period (2) + Cost Center (8) + Functional Area (7) + WBS Level 2 (6) + WBS Level 3 (4) 

 
 Example: 
 00WSHQ0808EPPSODEPD00011234 

  Budget Period: 2020 
  Cost Center:  APWSHQ0808 
  Functional Area: AP00PDEPPSODE000 
  WBS Level 2: AP.EX.PD00.01  (If no WBS fill with “PUBLICUSDA”) 
  WBS Level 3: AP.EX.PD00.01.1234  (If only a WBS Level 2, fill with “USDA”) 

 
Commitment Items  
Commitment items, also known as budget object classification codes (BOCC) and/or revenue source 
codes (RSC) are used by the Federal Government to record its financial transactions according to the 
nature of the services provided or received. 
 
Examples of BOCs 
 1100 – Personnel Compensation 
 2570 – Miscellaneous Services 
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 4200 – Insurance Claims and Indemnities 
 
Examples of RSCs 
 0100 – Operating Income 
 0200 – Revenue from services provided – exchanged (i.e., sales orders) 
 0202 – Revenue – Anticipated (i.e., AQI User Fees) 
 0203 – Commercial Activity – Exception (i.e., VS/PPQ User Fees) 

 
Link to APHIS FMMI Master Data:  FMD Quick Reference Guide  
Link to the BOC Manual:  https://nfc.usda.gov/FSS/Publications/FMS/boc.pdf  (PDF Searchable) 
 

https://www.aphis.usda.gov/aphis/ourfocus/business-services/applications-systems/fmmi/quick_reference_guide
https://nfc.usda.gov/FSS/Publications/FMS/boc.pdf
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APHIS Financial Information Flow 
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Accounts Payable 
 
Feeders or Interfaces 
WebTA/Payroll (Employee Payments) 
Concur (Govt Temporary Duty Travel) 
SmartPay 3 (Purchase Cards) 
WEX (Fleet Cards) 
PROP (Property) 
IAS (Procurement) 
Ameresco (Utilities) 
Metel (Telephone) 
  
Manual Entries 
IPAC*  
VADRs* 
ePRES (foreign payments) 
SPS (same day payments) 
Employee Reimbursements (SF-1164s) 
eFABS (Allowances) 
Misc Pay 
BSE 
Coop Agreements 
EEO Payments 
Training (SF-182) 
Fee Basis 
Grants 
Honorariums 
Indemnities 
Patent Royalties 
Postage 
Tort Claims 
Transportation 
UPS 
Contracts 
Adjustments 

Accounts Receivable 
 
Feeders or Interfaces 
Lockboxes 
VS User Fee System 
  
Manual Entries 
ACH 
FedWire 
IPAC  
Pay.gov 
Lockbox Rejects 
Sales Orders (SO) 
Billings (non-SO related) 
Modifications 
Transfers 
Refunds 
Write Offs 
 
SO Jobs FOB Runs 
Overhead 
RRB Billing 
 

 

 

 

 

*Feeders being developed 
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General Ledger Overview 
 

The United States Standard General Ledger (USSGL) provides a uniform Chart of Accounts and technical guidance 
to be used in standardizing federal agency accounting.  FMMI incorporates the United States Standard General 
Ledger (USSGL) and uses the USSGL's Chart of Accounts.   
 

GL account numbers are assigned within the predefined ranges detailed below. 
 

 
 

USDA APHIS’ GL structure is as follows:  the four-digit USSGL number, subsidiary GLs (sub-GLs), and the four-digit 
RSC/BOC.  These GL accounts roll up to the four-digit USSGL accounts.  
 

 

The G/L Chart of Accounts can be found in FMMI by running an ECC report located under:   
General Ledger Management > Financial Reports > General Ledger Reports > G/L Chart of Accounts Report 
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USSGL Link:  https://tfm.fiscal.treasury.gov/v1/supplements/ussgl.html   (PDF Searchable) 

https://tfm.fiscal.treasury.gov/v1/supplements/ussgl.html
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Sales Orders Intro 

Overview 
 

Sales Order (SO) - A document that is generated by the Servicing Agency to authorize the sale of products or 
services on receipt of the customer’s order (the customer’s Purchase Order). 

 
Sales Orders (SOs) are documents in the financial system, Financial Management Modernization Initiative (FMMI).  
These documents are entered into FMMI upon the signing of an agreement which authorizes the sale of services 
and sometimes goods of USDA APHIS to a customer.  The customers include commercial customers, state 
governments, local governments, universities, non-USDA federal agencies and Intra-USDA agencies. 
 
SOs can be used to track specific information of an agreement such as agreement dollar amount, various dates 
associated with the agreement and various descriptions.  These SOs are used in the process of assessing of 
indirect costs (Overhead), and the creation of customer bills known as Resource Related Billing (RRB).  However, 
SOs are not used for capturing costs, collections of customer payments and purchasing of materials because there 
are various accounting elements that perform those functions.  There are five SOs types and each type has a 
specific purpose depending on the type of customer, how customer bills are processed, terms of the agreement, 
and when budget authority is established. 
 
Purpose:   

• Organizations use SOs as a way to forecast or track sales 
• Can be used to track specifics of the agreement (dates, description, etc.) 
• Used in the APHIS Overhead (OH) and Resource Related Billing (RRB) processes 
• Used with Customers 

 
Not Used for: 

• Capturing costs  (WBS Elements do that) 
• Capturing collections  (Customers and Bills do that) 
• Purchasing (Purchase Orders do that, and are used with Vendors) 
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Sales Order Types – APHIS 
Order 
Type 

Name SO 
Number 
Begins 
With 

FMMI Fund Description 

RONA Reimbursable 
Order No 
Advance (Spend 
then bill) 

32 AP001600AR Sold-to Party – Cooperator - Federal Agencies –  
Non-USDA 
 
Budget Authority – Established when Sales Order is 
entered. 
 
Bill or Statement (Stmt) - Bills are processed through 
IPAC (by NFC). 

INTR Intra-USDA 
Agency 
Agreement 
(No Advances) 

36 AP001600AR Sold-to Party – Cooperator – Federal USDA Agencies 
 
Budget Authority – Established when Sales Order is 
entered. 
 
Bill or Stmt – Bills are processed through IPAC. 
 
Order Specific Field (Header Data) – Must include a 
P.O. reference number from USDA agencies currently 
in FMMI.  FMMI will validate against this P.O.   

ROWA Reimbursable 
Order with 
Advance 

33 
 

AP001600AR Sold-to Party – Cooperator – Commercial Customer 
 
Budget Authority – Established when the check has 
cleared in FMMI.  The authority is the amount of the 
check. 
 
Material – REIMB 
 
Bill or Stmt – RRB Bill run solely to move collection 
from liability to revenue GL.  No bill or stmt to 
customer.   

ROWE Reimbursable 
Order With 
Exception 
(No Advances) 

61 AP001600AR 
 

Sold-to Party – Cooperator – Commercial Customers, 
Universities, and State and Local governmental entities.   
 
Budget Authority – Established when Sales Order is 
entered. 
  
Bill or Stmt – RRB Bill Mailed Monthly or Quarterly 
(except WS OTC Accts – RRB Bills Not Mailed) 

TOWA Trust Fund Order 
with Advance 

37 
 

AP008226AV 
 

Sold-to Party – Cooperator – Commercial customers. 
 
Budget Authority - Established when the check has 
cleared in FMMI.  The authority is the amount of the 
check. 
 
Bill or Stmt - Customer Statement emailed monthly. 
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WS OTC ROWE SO Differences 
Purpose 
Over the Counter (OTC) Sales Orders were established to account for all WS reimbursable sales without creating 
an individual Customer Accounts and associated Sales Orders.  These may include, but are not limited to, 
customers paying at the time of service, small dollar amounts, and/or one-time transactions.  
 
SO Type 
ROWE 
The most common Sales Order type is called Reimbursable Order with Exception or ROWE.  The budget is 
established when the ROWE is entered and Resource Related Billing (RRB) is performed either monthly or quarterly 
depending on the terms of the agreement.  RRB captures unbilled expenses including indirect and direct expenses 
and creates a bill that is mailed to the customer, which helps them see the progress of the agreement.  ROWEs 
account for about 70% of all Sales Orders. 

Differences from other ROWE SOs 
DIFF 1: A customer number was established for each state office. 

o The name associated with the customer should read Wildlife Services, the name of the state, and 
OTC. 
 

 
 

DIFF 2: These customer numbers were set up to be account statement customers  
(i.e. 2 filled in Account Statement box – see screen shot below).  
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o OTC (account statement customers) collections post to the customer number.  This posting was 
done since many times collections are received prior to the bill being issued.  These postings keep 
these collections tied to a customer even though they are initially posted in a suspense fund (i.e. 
AP0006501A).   

o “Regular” ROWEs collections post directly to the bill number. 
 

 
 
DIFF 3: The billing address was set up with the Minneapolis FOB address (see screen shot below).   
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DIFF 4: Bills are generated by Resource Related Billing (RRB) monthly but are not mailed to the state offices.  RRB 

captures all eligible (billable) expenses posted to the SOs WBS and BP. 
 

DIFF 5:  FIFO (first in first out)- Each night, a nightly cycle will run that will apply any collections posted to a 
customer number and suspense fund (AP0006501A) to the oldest open bills created by resource related 
billing. 

 
If there are more unapplied funds on the customer number than there are expenses on the bill created by 
RRB, the remaining funds will sit on the customer number and suspense fund until the next round of RRB 
captures billable expenses.  If this happens there could be one collection that is partially applied to two 
different billing documents. 

 
If the bill created by RRB is larger than the amount of funds sitting on the customer number, the nightly 
cycle will apply all of the collection(s) to the bill.   When another collection arrives and is posted to the 
customer number, the next nightly cycle will apply that check to the bill.   This posting will continue until 
the bill is paid in full. 
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APHIS ROWE SO Flowchart 
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APHIS ROWA SO Flowchart 
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APHIS INTR vs RONA SALES ORDERS Flowchart 
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APHIS SO CREDIT MEMO PROCESS Flowchart 
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FMMI Intro 

Accessing FMMI 
 
Instructions 

1. Go to https://portal.fms.usda.gov/ 
 

 
2. The following screen will display.  Click on Click Here to Log in with your LincPass. 

 

 
 
 

3. The following screen will display.  Enter your PIN and click OK.   
 

 
 

4. The following screen will display.  Welcome to FMMI! 
 

https://portal.fms.usda.gov/
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Navigation in FMMI: 
 

 
 
Note: Second Level Tabs are “Role based” and tabs are visible if you have been assigned the role. For more 
about Roles please see the section named “Roles in FMMI”. 
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FMMI Report Types 

Overview 
The three main report types in FMMI are: 

1. ECC Report 
2. HANA / BOBJ Report 
3. BI Report (Being phased out) 

Determining FMMI Report Type 
• In general, you can tell what type of report it is by where it is located in FMMI.  If it is located under a BI 

tab, it is a BI report.  If it is located under a HANA tab, it is a HANA report.  If it is located under a BOBJ tab, 
it is BOBJ report.  If it is not located under a BI, HANA, or BOBJ tab, it is most likely an ECC report.   

FMMI Report Types 
• ECC 

o Real Time  
o Drill Down Capabilities 
o Similar to Excel 

 
Report Type Example = ECC – located under Second Level Tab and typically labeled with “….Reports” 
 

 
 

• BI 
o Not Real Time, a day or so behind (date is in upper right hand corner of report) 

 
Report Type Example = BI – located under “BI Reports” 
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• HANA 
o Real Time ECC Reports  
o Created by APHIS staff or USDA Headquarters 
o AR has HANA Reports and are found on the Second Level tab. 

 
Report Type Example = HANA – located under “HANA Accounts Receivable Reports” 
 

 
 

• BOBJ 
o Not Real Time BI Reports, a day or so behind (date is in upper right hand corner of report) 
o Created by APHIS staff 
o AR does not have any BOBJ Reports created currently 

 
Report Type Example = BOBJ – located under “BOBJ Reports” 
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• BI Favorites > BEx 

o Not Real Time BI Reports, a day or so behind (date is in upper right hand corner of report) 
o Created by APHIS staff 
 

Report Type Example = BEx – located under “BEx Portfolio” 
 

 
 

 
 

 
*NOTE:  FOB (FMD Mpls) currently only reconciles to ECC and HANA Reports.  These versions are the most 
standard versions to SAP (least customizations, least room for human error). 
 
*NOTE:  See Appendix A for FMMI Doc Types.  FMMI Doc Types are useful in reporting.  
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Roles in FMMI 
 

• If you have access in FMMI to perform a function, you have the role assigned to you.  If you do not have 
access to perform the function, you have not been assigned the role.   

• You are only allowed to request/obtain roles needed for your job due to OMB A-123/Internal Controls, 
Separation of Duties controls.  Each report or function mentioned in this document identifies the role 
needed to execute the report or perform the function.  This document should identify every FMMI role 
you may need to perform your job in relation to SOs. 

• You may request needed roles through your FMMI program lead or your supervisor.  They will need to 
submit the request to APHIS-MRPBS FMD Security <mrp.fas.security.team@aphis.usda.gov>. 

• For questions regarding the requesting process, see the New User Access Guide. 
• If you need assistance with deciphering roles please contact 

<mrp.fas.security.team@aphis.usda.gov>.   
  

mailto:mrp.fas.security.team@aphis.usda.gov
http://www.aphis.usda.gov/mrpbs/systems/fmmi/downloads/New_User_Access_Guide.docx
mailto:mrp.fas.security.team@aphis.usda.gov
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Display Sales Order (SO) 
 

Purpose 
Displaying a SO in FMMI provides a process to verify information pertaining to the sales order. Displaying a SO 
allows internal customers a way to ensure the sales order has been entered and entered correctly.  The Display 
Document Flow screen of the SO allows the field to track specifics regarding bills, such as when it was billed, the 
amount of the bill, if the bill was cancelled, and whether a payment was received on the bill. 
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services SO verification needs. 
 
Report Type 
ECC 
 
FMMI Role 
Accounts Receivable, AR Evaluator Role 
 
Instructions 
STEP 1:  Go to: 

1. Accounts Receivable  
2. AR Evaluation  
3. Manage Sales Order  
4. Display Sales Order 
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STEP 2: If you know the SO Number you would like to view, enter the SO Number (i.e. 3200001871) in the Order 
 field and press the Enter key on the keyboard or click Search button. 

 

 
 
 
 
STEP 3:  If you don’t know the SO Number and want to search by WBS, enter the WBS Element  

(i.e. AP.RA.NA45.72.0031) and click Search. 
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STEP 4:  The following screen will appear which lists the WBS and associated SO documents. 
a. Note the following items: 

i. Bills (i.e. Debit Memo Requests) are eight digits long and start with the number seven (7).  
ii. Credit Memos (i.e. Credit Memo Requests) are eight digits long and start with the number 

six (6).    
iii. Sales Orders are ten digits long and start with the following numbers: 

1. ROWE  -  61 
2. RONA  -  32 
3. INTR  -  36 
4. ROWA  -  33 

b. Highlight the SO of your choice, and click the green check mark. 
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STEP 5: Regardless of whether you open your SO using a Sales Order Number or search for it using a WBS Element 
or a Billing Document, you will see the following screen.   This is your overview screen of the Sales Order. 

a. Note the following items:   
i. PO Date = Date SO was created 

b. Multiple SO Line Items often represent multiple projects or tasks 
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SO Line Item Drill Down Instructions 
 

STEP 1: To see the details of a SO line, Double Click on the WBS Element. 
 

 
 
STEP 2: The following screen will appear. This shows data ONLY for the SO line item selected. 
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STEP 3: Note the following items: 

a. Contract Data Tab – shows the following: 
i. Contract Start Date =  the start date of the period of performance 

ii. Contract End Date = the end date of the period of performance 
 

 
 
 
b. Account Assignment Tab – shows the following: 

i. Overhead Costing Sheet  
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1. INTR and RONA SOs, typically ZRRB1  
2. ROWE and ROWA SOs, typically ZWS17 and older sales orders may have ZWS13, 

ZWS14, ZWS15, ZWS16.  
ii. Overhead Key = Overhead Rate Charged 

1. ROWE and ROWA SOs, typically R0515, R1615, or R2715 (accounts for pooled job 
costs) 

2. If these two OH fields are blank, overhead has been waived.    
iii. Click on FM Account Assignment – shows the following:   

1. Commitment item = revenue source code.    
2. Funds Center (Cost Center) 
3. Fund  
4. Functional Area  
5. Funded Program (WBS element)  
6. Budget Period  

iv. Click the green check mark or the red “X” to close this screen. 
1. This brings you back to the main Account Assignment tab page. 

 

 
 

c. Texts Tab - only used on RONA and INTR SOs – shows the following: 
i. Other agency’s agreement or MIPR number  

ii. Any accounting information the other agency needs for them to process the billing on their 
side 
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iii. In some cases, such with a MIPR the whole line of accounting provided on MIPR must be 
entered 

iv. Name and contact information for both agency’s point of contact (POC), in case of questions 
v. This tab must be filled in at the time the SO line is established. Otherwise, we can not save 

and generate the SO number.    
 

 
 

d. Order Data Tab – only used on RONA and INTR SOs – shows the following: 
i. PO number 

1. RONA = the other agency’s agreement number or MIPR number 
2. INTR = the other USDA agency’s FMMI PO number  

ii. Purchase Order Item 
1. INTR = the line number of the purchase order  

iii. Your Reference 
1. NTR = TAS (Treasury Account Symbol)  

iv. This tab must be filled in at the time the Sales Order line is established. Otherwise, we can not 
save and generate the Sales Order number.    
 

 
 
Below is what the Order Data tab looks like: 
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e. US Federal Fields Tab – only used on RONA and INTR SOs – shows the following: 
i. As of October 1, 2014 all federal agencies must also have a componet TAS (Treasury Account 

Symbol) entered in so an IPAC billing can be transmitted via the Treasury Department to the 
other federal agency.  When submitting a request to have a Sales Order entered, please make 
sure that a TAS symbol is on the agreement.    
Note: For the military, the MIPR or MORD will have the TAS included in the line of accounting.  
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Tips: 

o If a SO has more than one line, you can navigate between the lines of the Sales Order even when 
you are looking at the line details by clicking on the First Item, Previous Item, Next Item, and Last 
Item buttons at the top of the screen.    

o To get back to the main header page from line detail page, click on the Back button.   
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SO Display Document Flow Instructions 
 
STEP 1:  To see the chronological details of the SO entry, billing, and refund transactions: 

a. If multiple lines on the SO, click on the WBS Element for the line you want to analyze, and click on 
“Display document flow” button.   

 
Note:  You must perform the same steps to view details on each line of the SO. 

 

 
 
STEP 2: The following screen will appear.  This shows data ONLY for the SO line item selected. 

a. Note the following items: 
i. The first line of the Document flow shows the SO number, the amount of the SO, the date the 

line was created on, and the status. 
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ii. The second line shows a Debit Memo Request (Bill Request).   A Debit Memo Request is the 
resource related billing job that pulled in the expenses.   This isn’t the ‘bill’ itself.  You can also 
see the amount of the expenses that are on the Debit Memo Request and the date the 
request was generated.  The Debit Memo request number is used to generate the Debit 
Memo.  The Debit Memo Request number starts with the number seven (7). 
 

 
 

iii. The third line shows the Debit Memo (009).  The Debit Memo generates accounting 
documents (the fourth and fifth lines).  The accounting document that starts with 300 is the 
one that will show up on your reports; and when a payment has been applied to this 
accounting document, the status will say Cleared.  The Debit memo number is the number 
that will show up on printed bills and IPAC transmittal sheets. 
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iv. This example also shows a second Debit Memo Request and Debit Memo.   Each time 
resource related billing is run on a SO, you will get a Debit Memo Request, Debit Memo, and 
the accounting documents. 
 

 
 

v. Credit Memo Requests - Credit memo requests are reset so the negative expense will be 
picked up on the next RRB run unless we’ve received a request to “refund” the money.  This is 
why they all show as zero dollars in the example. 



  

Page 45 of 216 
 

 
 

 
STEP 3: Drill Down into Documents by highlighting the accounting document number (i.e. 3000619756) and 
clicking on Display Document – pulls up the document – shows the following: 

a. Clearing document number applied to the bill starts with __ signifies: 
i. 30 = bill was cancelled 

ii. 24 = bill was paid with an IPAC payment 
iii. 14 = bill was paid with a check, wire, ACH or plastic card 
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STEP 4: Note the following payment document details, which is the Clearing document that begins with either a 
“30”. “24”, or a “14”: 

a. Text Field on the Clearing document–  
i. Check, Wire, ACH number 

ii. IPAC Document = blank 
b. Reference Field on the Clearing document – 

i. Check , Wire, ACH = the deposit ticket number 
ii. IPAC Document = IPAC Document Reference Number (DRN) – used to trace an IPAC 

payment 
 
STEP 5: To drill down into the Clearing document , Double Click anywhere on the top line of the billing document 
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a. The following screen will display.   
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Request New Sales Order 

SO, WBS, and SHC Request 
 
Purpose 
To coordinate the establishment of the SO, WBS and SHC, the following process has been put in place to ensure 
everything is created both properly and promptly. 
 
Instructions 
STEP 1: Log onto the SharePoint for your agency: 
 Wildlife Services (WS) 
 Plant, Protection and Quarantine (PPQ) 
Note: if you are Wildlife Services and do not have access to the SharePoint site you need to be added to the email 
group: APHIS-WS All Employees APHIS-WSAllEmployees@usda.gov 
If you are PPQ and do not have access to the SharePoint site please contact barrett.l.trimble@usda.gov 
 
STEP 2: Complete the Sale Order request form on SharePoint. 
 
STEP 3: Complete the Accounting Code Request Form found on the respective SharePoint sites and attach it to the 
SharePoint request form to establish new SHCs and WBSs in FMMI. 

1. SHCs – SHC Tab 
i. Only select the feeder systems where the code should be used.  Feeders include: 

1. Concur   Government travel transactions 
2. SmartPay2 / WEX Purchase/fleet card processing 
3. webTA   Employee time & attendance  
4. MASC   Other USDA systems (i.e., ABCO, PACS, PROP)  

5. IAS   Integrated Acquisition System (Purchasing) 
6. CPAIS   Real property system 

7. TRVL   Travel System for relocations 

2. WBS Elements – WBS Tab 
i. Programs are only allowed to request WBS Projects and Elements for reimbursable (RA) and 

trust fund (TF) purposes.   
ii. Requests to establish a new Expense (EX) WBS Project and Element must be submitted to 

PPD-BPAS for approval.  If the Functional Administrators (FAs) receive requests without PPD-
BPAS approval they will be returned to the requester.   

 

https://usdagcc.sharepoint.com/sites/aphis-mrp-fmd/svcs/aphis/SitePages/Wildlife%20Services%20Sales%20Orders.aspx
https://usdagcc.sharepoint.com/sites/aphis-mrp-fmd/svcs/aphis/ppq/SitePages/Home.aspx
mailto:APHIS-WSAllEmployees@usda.gov
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Verify New SO, WBS, and SHC 
 

FMMI New SO Data Entry Verification 
 
Purpose 
Displaying a SO allows internal customers a way to ensure the sales order has been entered and entered correctly.   
 
Verification Instructions:  (detailed instructions can be found in Display Sales Order) 
 

STEP 1: Header 
a. SO number begins with the correct digits  

i. ROWE  -  61 
ii. RONA  -  32 

iii. INTR  -  36 
iv. ROWA  -  33 

b. Customer name 
c. Dollar amount 

STEP 2:  Contract Data Tab 
i. Contract start date 

d. Contract end date 
STEP 3: Account Assignment Tab 

e. Overhead Costing Sheet 
i. Options and what they mean 

1. For RONA and INTR, it is ZRRB1 which is tied to 16.15% OH for all programs 
2. For WS ROWE and ROWA there are multiple costing sheets.  In order to bring the 

agency OH up to 5.15% as all APHIS programs are required, it was agreed to 
increase the agency OH and decrease the program OH by 1% each year and 1.15% 
the last year.  Currently this correlates to the fiscal year the change will take place 
(ie ZWS15 for FY15) but after fiscal year 2017 this will not change unless there is a 
change in either agency OH or program OH.   

a. ZWS13 = 1% agency OH and 15.15% program OH 
b. ZWS14 = 2% agency OH and 14.15% program OH 
c. ZWS15 = 3% agency OH and 13.15% program OH 
d. ZWS16 = 4% agency OH and 12.15% program OH 
e. ZWS17 = 5.15% agency OH and 11% program OH 

f. Overhead Key 
i. Options and what they mean 

1. Blank = OH has been waived (rare, requires Administrator or (designee) approval) 
2. R0515 = 5.15% 
3. R1615 = 16.15%  
4. R2715 = 27.15% and accounts for pooled job costs 

g. FM Account Assignment 
i. Commitment item = revenue source code.    

ii. Funds Center (Cost Center) 
iii. Fund  
iv. Functional Area  
v. Funded Program (WBS element)  

vi. Budget Period 
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New Shorthand Codes Verification 
 
Purpose 
To verify if a SHC request for activation (or deactivation) has been successfully completed in FMMI.   
 
FMMI Role 
Interface Table Maintenance Evaluator 
 
Instructions 
STEP 1: Go to  

a. Interface Table Maintenance  
b. Shorthand Code Evaluation  
c. Shorthand Code Table  
d. View Shorthand Code 

 

 
 
 
STEP 2: To search by WBS, enter the following data:   

a. Agency = 34 (APHIS) 
b. WBS Element = i.e.  AP.RA.RX47.72.0080 
c. Click Execute button to run the report 
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STEP 4: The report will populate as shown below 

a. Note the following items: 
i. Sys ID, which is the feeder system into FMMI 

ii. Status 
1. Active = Open 
2. Deactivated = Closed 

 

 
 
 
+
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New WBS Elements Verification (Where Applicable) 
 
Purpose 
To verify if a WBS Elements’ request for activation has been successfully completed in FMMI.   
 
Considerations 

• WBS Elements that are reused should already be open/active.   
 
FMMI Role 
Cost Management Reporter Role 
 
Instructions 
STEP 1: Go to  

a. Cost Management  
b. Cost Management Reports  
c. Project Systems  
d. WBS Master Data Report  

 

 
 
STEP 2: The following screen will appear.  Enter the following: 

a. WBS Element – i.e. AP.RA.RX47.72.0080 
b. Click Execute 
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STEP 3: The screen will populate as shown below.  Note the following items: 

a. WBS Element – if the screen populates and shows the WBS element, it is established 
b. Bill – only level 3 should be checked 
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Resource Related Billing Overview 
 
Resource Related Billing (RRB) is a standard SAP term used for billing Sales Orders.  RRB is a two-step process that 
is scheduled either Monthly or Quarterly depending on the terms of the agreement. 
 
RRB accesses one table which resides in the background of FMMI (named RIA_Cell.ALL) and this table contains 
information used in the RRB process.  RRB captures all billable expenses.  Non billable expenses include things like 
depreciation expense and accruals.  The RRB table is GL based and maintained by OCFO for all of USDA. 
 
 
Technical note:  RRB process is a two stage process. The first part of RRB creates the Debit Memo Request and the 
second part creates the Debit Memo and the Bill.  Please see the section named “SO Display Document Flow 
Instructions” earlier in this binder. 

 

 

Line Items – Actual Costs/Revenues Report (LIACR) 
 

Purpose 
The LIACR Report provides the FMMI expense documents posted to WBS Elements.  This report shows the 
Document Number, Document Type, Cost Element, Expense Amount, Doc Header Text, Line Item Description 
(Name), and the FMMI User Name, among other fields.  The report is highly customizable to limit or expand the 
data you wish to see.   
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services billing verification needs.  
• This report is the same report we use for the Overhead (OH) calculation reconciliation (eligible expenses), 

OH split reconciliation, and OH expenses posted.    
• This report does not reflect collections.   
• This report will not show expenses for your account which were posted incorrectly (ex. WBS FPDEFAULT).   

 
Report Type 
ECC 
 
FMMI Role 
Cost Management Reporter (ECC) 
 
Instructions 
 

STEP 1: Go to Cost Management  
STEP 2: Go to Cost Management Reports  
STEP 3: Go to   Line Items – Actual Costs/Revenues under Project Systems 
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STEP 4: To run by WBS element, enter the following data: 

a. WBS Element = i.e. AP.RA.RX30.73.1010 
b.  

STEP 5: Select Posting Dates = i.e. BLANK to 08/31/2019 (this example is running the report on the WBS is wide 
open search, you can limit it further to a specific time period) 
STEP 6: Select Layout = 1_USDA_RRB2 
STEP 7: Click on Further Settings, change maximum number of hits to 99999 in the popup window then click on the 
green check mark. 

 
 

 
 
 
STEP 8: Click Execute to run the report 

Note: The report layout 1_USDA_RRB2 is customized at this time to pull only for budget periods 18XX and 19XX  
This report is also customized to remove all non-billable expenses.   If you need to limit or view any other budget 
period or expenses, you will have to use the filtering process explained in FMMI Reporting Tips and Tricks.    

 
 
 

STEP 9: The report will populate as shown below 
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STEP 10: Commonly Used Additional Features 
 

a. Drill down - highlight line then double click on it 
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b. Filter  - Highlight column and then select Set Filter 
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c. Subtotals 
d. Change Layout 
e. Select Layout 

 
STEP11: If you need to print the report, follow the instruction to export to Excel and print the exported file.   
 
STEP12: To export to Excel 

a. click Menu  
b. Go to List  
c. Go to  Export  
d. Go to Spreadsheet  
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STEP 13: The following box will appear 
 

 
 
 

STEP 14: An Excel version will appear on your desk top and will be saved in the location you chose above.   
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Obligation/Payments Overview 
 

FMMI Master Data is not derived for most manual obligation/payment entries, and mistakes can and do happen 
(ex. multiple Fund Centers for one WBS).  It is important for people to use the most accurate data they can on 
every document.   

Types of Payments and FMMI Requirements 
 

Manually Entered Obligations/Payments – these are payments which are manually entered by FOST or IOAT into 
FMMI.   

Examples:  1164, Training, Coop Agreements, Misc. Pays, BSE, Fee Basis, Indemnities, Transportation, 
Postage, etc. 
Required FMMI Master Data:   

• Obligation Already Entered = Obligation Number 
• No Obligation Established = Budget Period, Fund, Fund Center, Functional Area, WBS Element 

(where applicable), Commitment Item (BOC) 
 
Feeder/Interface Payments – these are payments which are loaded into FMMI through automated feeder 
systems.   

Examples:  Payroll (WebTA), Travel (Concur), Procurement (IAS), Credit Card (SmartPay2/WEX), etc. 
Required FMMI Master Data:  Short Hand Code (SHC), Commitment Item (where applicable) 
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Payments Feeder Systems Overview 
 
A financial feeder system (or also known as a secondary financial system) is a system that supports functions with 
both financial and non-financial aspects, such as logistics, acquisition, and personnel, and typically feeds financial 
data into the primary financial system.    
 
The USDA has several feeder systems listed below.  Along with the transactions that are processed through the 
feeder systems, FMMI also sends files to the systems updating the SHCs.  Below are the current timelines when 
activity happens. 

  
 

 
 
 
 
 
 
Feeder systems interact differently with FMMI.  The one 

commonality is that if there is no available budget for the SHC provided, the entry will reject (payroll is the 
exception).  Rejected documents can cause delays in payments being issued and possible service interruption.  
 
SmartPay3 (US Bank) and WEX (Citi Bank) experience a very high number of rejects.  There are a few primary 
reasons for the issues:  
 Invalid/Missing BOC 
 Invalid/unfunded default code 
 Invalid/unfunded code used for reallocation 

 
Agency credit card transactions post in FMMI as either a ZW (SmartPay3) or ZX (Fleet Card) document types.  They 
post to the default Short Hand Code (SHC) and Business Object Code (BOC) that is on file for the cardholder.  If 
you need to change the default SHC or BOC you will do a reallocation (ZS document type) in Access Online to 
make the changes.  If the SHC is invalid or the budget amount is not sufficient to cover the charge either the 
ZW/ZX/ZS document can reject in FMMI.  Financial Analysts from IOAT will contact the card holder to let them 
know of the reject.  To correct these rejects the program will need to increase funding on the SHC or provide new 
accounting elements for this charge.  If the original ZW/ZX document rejects you will not be able to do a 
reallocation later in Access Online since the system cannot locate the original document.  Any changes then would 
have to be done on an SU document.  See Appendix B for reallocation guidance. 
 

List of APHIS Feeder Systems  
Concur   Government travel transactions 
SmartPay3 / WEX Purchase/fleet card processing 
WebTA/Payroll  Employee time & attendance/other employee payments 
MASC   Other USDA systems not specifically identified (i.e., ABCO, PACS, PROP)  
IAS   Integrated Acquisition System (Purchasing) 
CPAIS   Corporate Property Automated Information System (real property system)  
MLINQS  Travel System for relocation authorizations and vouchers 

Feeders Inbound to FMMI 

Concur Real Time (web svc) 

IAS Real Time (web svc) 
SmartPay3 5:00 am (M-F) 
MLINQS 5:00 pm (M-F) 
WEX ??? 

Published Shorthand Codes 
MASC (includes PROP, 
ABCO, MLINQS) 

Daily            10:00 am 
                       3:00 pm 
                     11:00 pm 

Concur Daily            11:00 pm 

SmartPay3 / WEX Daily               7:30 pm 
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IPAC Overview 
 
IPAC is a Treasury process/system used to move funds between federal agencies without processing manual 
payments or collections.  IPAC uses the Agency Location Code (ALC) through Treasury as we would use our bank 
account information to transfer funds to or from our bank account.   
 
NFC processes all IPAC transactions for the USDA, both intra-agency (i.e. USDA = INTR) and interagency (i.e. non-
USDA = RONA), into FMMI. 
 

Intra-Agency Collections = NFC Transfers Funds = Sales Orders (INTR) 
Interagency (IPAC) Collections = Treasury Transfer Funds = Sales Orders (RONA) 
 
IPAC Payments = Purchase Orders 

 
IPAC Document Reference Number (DRN) - A unique identification number that is automatically assigned to each 
interagency transaction entered into the IPAC System.  

 
Example – IPAC Collection Document 
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For more information regarding IPAC, please visit the following Treasury Link:  
https://fiscal.treasury.gov/files/ipac/IPAC_Guide_Agency.pdf 

https://fiscal.treasury.gov/files/ipac/IPAC_Guide_Agency.pdf
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Payroll Employee Level Detail Report 
 
Purpose 
The Payroll Employee Level Detail Report provides employee payroll details.   
 
Considerations 

• This report only shows payroll expense entries through WebTA (ZP docs), and will not show B2s affecting 
payroll or payroll processed any other way (ex. ePRES, State Dept). 

 
Report Type 
BI 
 
FMMI Role 
Accounts Payable, BI Reporter 
 
Instructions 
STEP 1: Go to Accounts Payable > BI Payroll Reports > Payroll Employee Level Detail Report 

 

 
 
STEP 2: Variable entry screen for report will appear.  Enter the desired parameters to execute the report.   
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STEP 3: To run by WBS element, enter the following data: 

a. Fiscal Year = i.e. 2015 
b. Fiscal Period = i.e. 1 (October) 
c. WBS Element = i.e. AP.RA.RX01.72.0018 
d. Optional: click Check and if search criteria was entered correctly, a description will appear in the 

Description column 
e. Click OK to run the report 

 

 



  

Page 67 of 216 
 

 
STEP 4: The Report will generate and the layout can be modified to display as shown below, or to your preference. 

 

 
  

STEP 5: Commonly used additional features: 
a. Create/save variant 
b. Filter 
c. Drag and Drop 

 
 

STEP 6: To print PDF the report click Print Version.   
 

 
 
STEP 7: After Print Version is clicked, the following box will appear, click OK. 
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STEP 8: Click OPEN 
 

 
 
STEP 9: Click on the print icon. 

 

 

 
 
 
 
STEP 10: Export to Excel, click Export to Excel  
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a. After Export to Excel is clicked, the following box will appear, click Open. 
 

 
 

b. Click Yes and the report will automatically open in Microsoft Excel. 

 

c. To enable editing, click the Enable Editing box shown 

 

*Note:  PPC is Pay Period Covered.  PPP is Pay Period Performed/Entered in PACS.  These will be different for a 
corrected TA. 

 

 



  

Page 70 of 216 
 

 
GL Accounts within this report 

6100001101 BASE PAY - US NON-WAGE BOARD-FULL-TIME 
PERM 

6100001104 BASE PAY - US WAGE BOARD-FULL-TIME PERM 

6100001105 EMPLOYEE INDEBTEDNESS 

6100001109 TIME OFF AWARDS 

6100001121 BASE PAY - US NON-WAGE BOARD-FULL-TIME 
TEMP 

6100001131 BASE PAY - US NON-WAGE BOARD-PART-TIME 

6100001153 OTHER AWARDS 

6100001160 NIGHT DIFFERENTIAL 

6100001163 SUNDAY DIFFERENTIAL - NON-WAGE BOARD 

6100001164 SUNDAY AND NIGHT DIFFERENTIAL 

6100001170 OVERTIME - NON-WAGE BOARD 

6100001171 OVERTIME - WAGE BOARD 

6100001180 HOLIDAY PAY - NON-WAGE BOARD 

6100001183 LUMP SUM PAYMENTS - PERMANENT-NON-WAGE 
BOARD 

6100001205 FEHB - EMPLOYEE SHARE PAID BY AGENCY 

6100001274 TSP - GOVERNMENT-BASIC CONTRIBUTION 

6100001275 TSP - GOVERNMENT-MATCHING CONTRIBUTION 

6100002106 TRAVEL REIMBURSEMENTS 

6400001201 FICA - AGENCY CONTRIBUTION 

6400001202 FEGLI - AGENCY CONTRIBUTION 

6400001203 FEHBA - AGENCY CONTRIBUTION 

6400001204 CSRS 7% COVERAGE CODE 1 - AGENCY 
CONTRIBUTION 

6400001213 HIT - AGENCY CONTRIBUTION 

6400001214 TRANSITIONAL RETRMT CONTRI - CIVIL SERVICE 

6400001251 TRANS OASDI CONTRI - CIVIL SERVICE 

6400001264 FERS CONTRI - REGULAR 

6400001269 FULL OASDI CONTRI - FERS (L) 
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WS SO Overhead (OH) 

Overview 
SO OH is a percentage of eligible direct expenses.  Eligible direct expenses for OH include all billable expenses, less 
OH, which is an indirect expense.  (RRB includes all eligible expenses including Overhead.)  Direct expenses are 
expenses (like Supplies and Materials, and Payroll of the field worker) that directly impact the work performed.  
Indirect expenses indirectly impact the work performed (example: the state budget analyst’s salary) 
 
FMMI SO OH Calculation 
       Total Eligible OH Expenses for Period 
x     OH Rate 
=     Overhead Charged on Account for Period 
 
WS SO OH Rates 
WS SO Overhead percentages range from 0% to 27.15%.   

• 0% OH rate would mean that all OH was waived in the agreement (this is rare and requires Administrator 
(or designee) approval).   

• 5.15% means that WS waived their OH in this agreement as this amount is solely for MRPBS. 
• 16.15% means that regular OH is included in this agreement. 
• 27.15% means that regular OH plus pooled job costs are included in this agreement. 
• Percentages in between any of the above signify some range of variation from the above listed standards. 

 
Pooled Job Costs (PJC) 
Pooled job costs include any item of expense that may be directly identified with a particular project or program, 
and is distributed across all identifiable projects or programs to which it pertains (see Wildlife Services Policy, 
Chapter 2 Section 2.215, dated August 23, 2013).  An example would be the cost of a pick-up truck. The truck is 
used for multiple agreements. 
 
Initially in FMMI PJCs were intended to be picked up in the cost allocation cycle.  Cost allocation is a process in 
FMMI that moves certain indirect costs directly to accounts as billable expenses, based on established criteria in 
tables (i.e. spreads truck cost to multiple projects).  Later it was learned that cost allocation does not work with 
SOs and that is why PJCs are now included in the OH rate where needed.   
 
WS SO OH Split Example 

1. MRPBS = 5.15% 
2. WS OH = 11% 
3. WS PJC = 11% 

 
Direct vs Indirect Costs 

• Direct costs are those that are directly attributable to a project in full expense amount (i.e. program 
payroll, project supplies, etc). 

• Indirect costs are those that are not directly attributable to a project in full expense amount (i.e. Admin 
support, equipment repairs, etc).   

Please refer to Wildlife Services Policy, Chapter 2 Section 2.215, dated August 23, 2013 for more definitions and 
examples. 
 
*Note:  All portions of the FMMI WS SO OH rate are often referred to as just OH or indirect costs, but may also 
contain PJCs. 
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WS SO OH Reconciliation 
 
FMMI SO OH Calculation 
       Total Eligible OH Expenses for Period 
x     OH Rate on Account 
=     Overhead Charged on Account for Period 
 
Instructions 
STEP 1: To obtain the total eligible OH expenses for the period, run the LIACR Report for the appropriate  

a. WBS Element  
b. Posting Date Range 
c. Choose layout /WS OH RECON 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: Multiply this total by the OH Rate on the account 
STEP 4: This total should equal the total OH charged on the account for the period 
 
Example 

AP.RA.RX36.72.0121 
04/01/14 – 04/30/14 
/WS OH RECON 

 
BP 14XX  (SO 6100009040) 

 
$  227.24  Eligible Expenses 
X  0.2715  OH Rate on SO 
$    61.69  OH Charged on Acct for Period 
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WS SO OH Charged 
 
Instructions 
STEP 1: To obtain the total OH charged for the period, run the LIACR Report for the appropriate: 

a. WBS Element 
b. Cost Element 6100980000 (OH GL) **Note: on 12/07/17 OH began being charged to 6100940200 
c. Posting Date Range 
d. Choose layout /WS OH CHRGD 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This total should equal the total OH charged on the account for the period 

 
Example 

AP.RA.RX36.72.0121 
6100980000 
04/01/14 – 04/30/14 
/WS OH CHRGD 
 
BP 14XX  (SO 6100009040) 
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WS SO OH Split 
 
Instructions 
STEP 1: To obtain the OH split for the period, run the LIACR Report as follows: 

a. AP.RA.*and AP.WS.* 
b. Cost Element 6100980000 (OH GL)  **Note: on 12/07/17 OH began being charged to 6100940200 
c. Posting Date Range 
d. Choose layout /WS OH SPLIT 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: Review the results for the appropriate WBS element 
STEP 4: This should show the OH split for the account for the period 
 
*Note:  If you know all of your needed WBS elements, it would be best to limit the report to just those when 
running, or to use the wildcard trick (see FMMI Tips and Tricks) to lessen the results.  Otherwise, you may have to 
change the Further Settings to 20,000 lines or more to get to your account.  If you have to go this massive route, 
print to PDF and it will be searchable.   

 
Example 

AP.RA.* and AP.WS.* 
6100980000 
04/01/14 – 04/30/14 
/WS OH SPLIT 
 
AP.RA.RX36.72.0121 
BP 14XX  (SO 6100009040) 
Fund/Cost Center APWSER3636 (SO 6100009040) 

 
Note: This report will bring up all WBSs that have been assessed OH for the period.  You have two options for 
finding the WBS that you are looking for. 1) export the report to Excel and Find(Ctrl + F) the WBS or 2) filter the 
Line Items report based on document number (if you know it) like in the screen shot below: 
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*Note:  There is an OH Sender/Receiver Table in FMMI which defines the OH split based on Fund/Cost Centers, 
the OH Costing Sheet, and the OH Key.  Pat updates this table based on a spreadsheet she receives from BESB.  If 
you do not get the results you were expecting for the OH split, it is likely that the OH Sender/Receiver Table for 
the associated Fund/Cost Center is wrong.  Contact MRP.Billing.Requests@aphis.usda.gov for assistance.  (See 
screenshot below for an example of the table showing the OH split definition) 
 

 

 

mailto:MRP.Billing.Requests@aphis.usda.gov
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WS SO OH Earned 
 

Instructions 
STEP1: To obtain the OH earned by WBS Element, run the LIACR Report as follows: 

a. WBS Element (i.e. AP.RA.POOL.WS.ER36) 
b. Cost Element 6100980000 (OH GL)  
c. Choose layout /WS OH SPLIT 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This should show the OH earned for the WBS Element 
 
Example 
 AP.RA.POOL.WS.ER36 
 6100980000 
 /WS OH SPLIT 
 
 14XX 
 

 
 

*Note:  OH earned comes from the OH split (sender/receiver rules).  It shows as a negative expense in FMMI.  This 
is where you see it in the SOF PTD as well, as a negative expense. 



  

Page 77 of 216 
 

 

WS SO OH Spent 
 

Instructions 
STEP 1: To obtain the OH spent by WBS Element, run the LIACR Report as follows: 

a. WBS Element (i.e. AP.RA.POOL.WS.ER36) 
b. Choose layout /WS OH SPENT 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This should show the OH spent for the WBS Element 
 
Example 
 AP.RA.POOL.WS.ER36 

/WS OH SPENT (NOTE:  This layout excludes OH earned.) 
 14XX 

 

 

*Note:  This report does not include Commitments or Obligations, which do affect budget availability.  Use the 
SOF PTD or ULO to review any Commitments or Obligations also affecting your account. 



  

Page 78 of 216 
 

WS SO OH Available 
 

Instructions 
STEP 1: To obtain the OH availability by WBS Element, run the LIACR Report as follows: 

a. WBS Element (i.e. AP.RA.POOL.WS.ER36) 
b. Choose layout /WS OH AVAIL 

STEP 2: Filter to the appropriate BP, if needed 
STEP 3: This should show the OH available for the WBS Element 
 
Example 
 AP.RA.POOL.WS.ER36 

/WS OH AVAIL  (NOTE:  This layout includes both OH earned and OH spent.)  
 14XX 
 

 

*Note:  This report does not include Commitments or Obligations, which do affect budget availability.  Use the 
SOF PTD or ULO to review any Commitments or Obligations also affecting your account.   
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LIACR Report Layouts 
 

These ECC LIACR Report layouts were created by FMD for both FMD and WS use.   

We do want to collaborate to make these layouts as efficient and effective (into the best format) as possible for 
both parties.   

We do not want each WS office to modify the layouts and save them either as the current layout name 
(overwrite) or a new layout name, without collaborating with both FMD and WS.  We all need to share the same 
layouts in order to save space and system resources, and keep them accurate.  If we end up with multiple layouts, 
there will be more to scroll through. Then, at some point we will likely have to clean this up and delete a bunch. 

For additional information regarding layouts and variants see FMMI Tips and Tricks. 
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Collections 

Payments to USDA APHIS Overview 
 
There are approximately 240,000 payments (primarily customer payments) to the USDA APHIS each year 
(approximately 20,000 per month).  On top of that, APHIS also posts payments for three additional USDA 
agencies.  USDA uses semi-automated posting processes (i.e. lockboxes).  For these reasons, it is critical that 
each payment is sent to the appropriate place using the correct payment processing data and including the 
proper remittance advice.  If any of these are not accurate, there is a good chance the payment either not being 
received by APHIS or being received and misapplied.   
 
 
Three important pieces to every APHIS Customer Payment: 

1. How the payment is sent    
Payments to USDA APHIS Instructions (see appendix E)  

2. Where the payment is sent    

APHIS Lockbox Instructions and Payments to USDA APHIS Instructions (see appendix E) 
3. Remittance Advice Included on payment   

APHIS Remittance Advice Instructions (see appendix E) 
 
 
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by phone 
at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.   
 
 

  

mailto:ABShelpline@usda.gov
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Payments to USDA APHIS Instructions 
 

The procedures below are for payments to USDA APHIS.  Payments are accepted via Check, Money Order, ACH, 
Wire Transfer, PayPal, Debit Card, Credit Card, or IPAC. 

 
Check or Money Order: Make payable to “USDA APHIS”. Checks drawn from a foreign bank 
must say “Payable in US Dollars.” Mail your payment to the lockbox address listed on your 
bill or refer to the APHIS Lockbox Instructions for additional guidance.  
 

Debit Card, Credit Card, PayPal, or ACH:  payments can be made at www.pay.gov. 
 
For step-by-step Pay.gov instructions refer to the Pay.gov Instructions. 
 
Bank ACH: processed through Remittance Express by the Federal Reserve Bank of Richmond.  
 
You will need the following information to remit a payment via ACH, if not using pay.gov:        

ABA:  051036706 
Name on Account: USDA, MRP, APHIS 
Account Number:  540021 

 
Wire Transfers: processed through the Federal Reserve Bank of New York.  

You will need the following information to remit a payment via Wire Transfer: 
ABA:  021030004 
Name on Account: USDA, APHIS  
Account Number:  12403400 

 
DO NOT USE THE BANK SWIFT CODE for any Wire Transfers.  
This may cause your payment to be rejected. 
 
International Wire Transfers:  must be sent through a US correspondent bank (i.e. third 
party or intermediary bank) before going to the Federal Reserve Bank of New York. The US 
correspondent bank information should be in bold. 
 
IPAC:  direct payment processing for federal agencies through US Treasury.   
 
You will need the following information to remit a payment via IPAC: 

APHIS ALC:  12403400 
 

 
 
Note: Any fees associated with the financial transaction chosen (ie bank funds transfer, credit card, etc) are the 
responsibility of the remitter. Please check with your financial institution for fee considerations.   
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by phone 
at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.   

 

United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 
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USDA APHIS, Wildlife Services 

Remittance Advice Instructions 
 

The procedures below are for remittance advice for payments to the USDA APHIS.   
 
Remittance Advice: The following information must be included on your payment(s) and is crucial to 
ensuring the proper posting of your payment.  Determine your remittance advice based on your 
customer type below.   
 

Wildlife Services Remittance Advice by Customer Type: 
 

• WS Advance (Down Payment) 
o WBS Element (ex. “AP.RA.xxxx.xx.xxxx”) 
 

• WS Reimbursable (non-OTC Accounts) 
o Bill Number only, if a bill exists (ex. “BD 300000789”) 

 
• WS Reimbursable – OTC Accounts 

o Customer Number (ex. “Cust No. 3361234”) 
 
Customer Types: 
 
Wildlife Services (WS) Customer Payments 
 

Advance Payments – agreement includes payments in advance of services received. 
 
Reimbursable Payments – agreement includes payment after services are received. 
 
Over the Counter (OTC) Payments – may include, but not limited to the following: 

• customer  is paying at the time of service,  
• often small dollar amounts, and/or  
• one-time transactions.   

 
 
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by phone 
at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.   
 
 
 

United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 

Operations 
Branch 

 

mailto:ABShelpline@usda.gov
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USDA APHIS Lockbox Instructions 
 
The procedures below are for mailing in payments to the USDA APHIS via check or money order. USDA 
APHIS uses commercial bank lockboxes to route and post incoming payments.   
 
What is a Lockbox?  A service offered by banks to companies in which the company receives payments 
by mail to a post office box and the bank picks up the payments, deposits them into the company's 
account, and notifies the company of the deposits.  
 
Make checks or money orders payable to “USDA APHIS.” Checks drawn from a foreign bank must say 
“Payable in US Dollars”. Mail your payment to the lockbox address listed on your bill or form or refer to 
the below instructions for additional guidance.  
 
 
Remittance Advice: The remittance advice included on your payment(s) is crucial to ensuring the 
proper posting of your payment.  Determine your remittance advice based on your customer type and 
the associated instructions found on APHIS Remittance Advice Instructions.   
 
**CAUTION**    

APHIS General Lockbox and Collections Sort (in order) 

• Customer Account Number/ Billing Document Number 
• Down Payment 

• COD/ SHC 
• Unidentified 

 
 

 
Link to Lockbox Addresses: 
USDA APHIS Collection Types and Where To Send Them (Lockbox Addresses) 
 
 
Questions:  Contact the ABS Helpline for any assistance in making a payment to the USDA APHIS either by phone 
at 612-336-3400 or 877-777-2128 or by email at ABShelpline@usda.gov.   
 
 
 
 
 
 
 
 

United States Marketing and Financial Financial 
Department of 
Agriculture 

Regulatory Programs Management 
Division 

Operations 
Branch 

 

https://www.aphis.usda.gov/aphis/ourfocus/business-services/financial-management-division/collection_types
mailto:ABShelpline@usda.gov
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APHIS General Lockbox Process Flowchart 
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PAY.GOV Instructions 
 

Purpose 
Pay.gov is a collection tool for federal agencies to collect via credit card, debit card, PayPal, or ACH.  Please note 
that these collections may be entered directly into pay.gov either by internal staff or by external customers.   
 
Considerations 

• These instructions were specifically tailored to meet the needs of Wildlife Services customers.   
 
Instructions 
STEP 1:  Go to www.pay.gov 
 
STEP 2:  Click on FIND AN AGENCY 
 

 
 
STEP 3:  Click on “Agriculture (USDA): Animal and Plant Health Inspection Service (APHIS)” 
 

 
 
 

STEP 4:  Under Animal and Plant Health Inspection Service (APHIS) Customers, click on “Continue to the Form” 

http://www.pay.gov/
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STEP 5: Click on “Continue to the Form” 
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STEP 6:  Fill out the Required Fields.   
 
At the bottom of the form you will see a question for “Service Provided By”, click on the drop-down box to get the 
menu and choose the Program for which you are paying, in this case WILDLIFE SERVICES. 

 
 
STEP 7:  Enter your Billing Document Number(s) and Amount(s).   
 
For non-billed customers (i.e. OTC Sales), enter your Customer Account Number (7-digit number) and the Amount 
you are paying.  If the Customer Account Number is not known, enter something like “Wildlife Services-Nebraska” 
or the state you are doing business with for us to be able to research the payment. 
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STEP 8:  Click on “Submit Data” 
 
STEP 9:  Choose the type of payment method you would like to use and click on “Next”  
 

 
 

STEP 10:  Enter all of the required payment information for the payment method chosen and click on “Review and 
Submit Payment” 
 
 
 
 
STEP 11:  Review the payment information.  If all information is correct, put a check in the box next to the 
authorizing statement and click on “Submit Payment” 
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STEP 12:  Either print or save a copy of the payment confirmation for your records.  This payment confirmation 
will be emailed to each email address submitted with the payment as well. 
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DOWN PAYMENT REQUEST 

 

Animal and Plant Health Inspection Service (APHIS) Wildlife 
Services 

 
 
 
Date: 
 
WBS Element:  
 
Amount Requested:  
 
APHIS Wildlife Services Agreement Number: 
 
 
In accordance with your agreement with USDA-APHIS-Wildlife Services, we are required to collect 
funds prior to performing services. 

Please remit payment in the exact amount requested along with this form to the address below in a timely 
manner consistent with your agreement with USDA-APHIS-Wildlife Services. Please reference the WBS 
Element on the payment/check. 

USDA, APHIS, General 
PO Box 979043 
St Louis MO 63197-9000 
 
If you have questions regarding this form, please contact your APHIS-Wildlife Services office. 
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APHIS Form 94 Instructions 
 

Record of Public Funds Received is a form APHIS uses to submit money collected by APHIS employees. Many 
APHIS employees, by virtue of their official capacity, will receive funds due to APHIS. These funds need to be 
documented on an APHIS Form 94 when a payment is sent in with no other posting information.  The purpose of 
this form is to ensure proper and timely posting of collections. 

 
Following are instructions for preparing the APHIS From 94. 

 
All Checks:  must be made payable to “USDA APHIS.” 

 
Foreign Checks:  checks drawn from a foreign bank must say “Payable in US Dollars.” 

 
Cash:  Do not send cash. If cash is collected, obtain a money order from a financial institution. Do not 
convert the cash to a personal check. Do not take the cost of the money order from the cash received. If 
necessary, use personal funds for the cost of purchasing the money order and claim reimbursement on 
an SF-1164, Claim for Reimbursement for Expenditures on Official Business.  

Do Not Hold Collections:  Forward funds collected on behalf of APHIS along with the original APHIS Form 
94 to the address listed on the form in accordance with the following regulations.  In general, send in 
checks by Thursday of each week, regardless of the amount accumulated, and on the day(s) when 
collections reach or exceed $5,000 total.  Regulations for collecting funds on behalf of the federal 
government can be found at Treasury Financial Manual, Volume I, Part 5, Chapter 2000- Depositing 
Domestic Checks and Cash Received in Over the Counter (OTC) Collections, Section 2055- Frequency of 
Deposits and 31 U.S. Code § 3302 - Custodians of money.  

Notification of Receipt of Collection:  Retain a copy of the APHIS Form 94 until you receive a receipted 
copy back from MRPBS collections staff.  MPRBS collection staff will return a copy of the APHIS Form 94 
to the sender acknowledging receipt of the collection.  The receipted copy is for your records. 
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APHIS Form 94, Completion Instructions 
 

1. Transmitted Number – Used by the submitting office at their discretion. 
 

2. Date Forwarding – Enter date the APHIS Form 94 is being submitted. 
 

3. To – This is pre-populated with the correct remittance address for miscellaneous collections. 
 

4. From – Enter name and address including zip code of the submitting office. 
 

5. Date Received – Enter the date the money was received. 
 

6. For MRPBS-ASD use only – Leave this blank. 
 

7. Amount – Enter amount of the money received for each transaction. 
 

8. Remitter – Enter the name of the remitter. 
 

9. Purpose/Accounting Code – Enter the remittance advice following APHIS Remittance Advice Instructions. 
 

10. Total Amount Sent – Enter total of all the dollar amounts on the APHIS From 94. 
 

11. Sent By – Printed name and signature of the person submitting the APHIS Form 94. 
 

12. Title – Enter the title of the person sending the APHIS Form 94. 
 

13. Amount – Leave blank. 
 

14. Received By – Leave blank. 
 

15. Date – Leave blank. 
 

16. Title – Leave blank. 
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APHIS 94 Form 
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Collections Reports  

Daily Collections Report 
 
Purpose 
The Daily Collections Report provides detailed information about each collection.  This report will display all 
accounting documents for Customer and Non-Customer collections.  The report is highly customizable to limit or 
expand the data you wish to see.   
 
Considerations 

• These instructions have been tailored for Wildlife Services to view their Sales Order collections.   
 
Report Type 
BI 
 
FMMI Role 
Accounts Receivable, BI Reporter 
 
Instructions 
STEP 1: Go to Accounts Receivable > BI Accounts Receivable Reports > Daily Collections 

 

 
 
STEP 2: Variable entry screen for report will appear.  Enter the desired parameters to execute the report.  
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STEP 3: To run by Funded Program (WBS Element), enter the following data: 

a. Document Type = pre-filled (do not change unless you are certain of the exact doc type you need) 
b. Business Area = i.e. AP00 (APHIS) 
c. Fiscal Year = i.e. 2011; 2012; 2013; 2014; 2015 
d. Funded Program = i.e. AP.RA.RX36.72.0072 
e. Optional: click Check and if search criteria was entered correctly, a description will appear in the 

Description column 
f. Note:  If you know more specific data, you may use any of the other fields as well, (i.e. Check Number 

or Posting Date Range).   
g. Click OK to run the report 

 

 
 

STEP 4: The Report will generate and the layout can be modified to display as shown below, or to your preference 
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STEP 5: To run by Customer Number, enter the following data: 
a. Document Type = pre-filled (do not change unless you are certain of the exact doc type you need) 
b. Business Area = i.e. AP00 (APHIS) 
c. Fiscal Year = i.e. 2011; 2012; 2013; 2014; 2015 
d. Customer Number = i.e. 0003363845 
e. Click OK to run the report 

 

 
 
STEP 6: The Report will generate and the layout can be modified to display as shown below, or to your preference 
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STEP 7: Commonly used additional features: 
a. Create/Save Variant 
b. Filter 
c. Drag and Drop 
d. Save As/Open (Layout) 

 
STEP 8: To print PDF the report click Print Version and go to step 9 OR to export to Excel, click Export to Microsoft 
Excel and go to step 10.   
 

 
 

STEP 9: After Print Version is clicked, the following box will appear; Click OK and a PDF version will be available to 
print or save.   

 

 
 
STEP 10: After Export to Excel is clicked, the following box will appear, Click Open 

 

 
 
The following security message will appear, click Yes and the report will automatically open in Microsoft 
Excel 
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To enable editing, click the box Enable Editing box shown 
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GL Accounts 
The following GL Accounts are used in the Daily Collection Report: 

 GL ACCOUNT  GL NAME  GL DESCRIPTION 
1010230000 Fund Balance With Treasury (FBWT-

COL Section 3/2) 
The aggregate amount of funds on 
deposit with the U.S. Department of the 
Treasury, excluding seized cash 
deposited 

1010330000 Fund Balance With Treasury (FBWT-
COL Section 3/3) 

The aggregate amount of funds on 
deposit with the U.S. Department of the 
Treasury, excluding seized cash 
deposited 

1310000000 Accounts Receivable   The amount due from others when the 
right to receive funds accrues. This may 
result from the performance of services, 
the delivery of goods, or court-ordered 
assessment. This account does not close 
at yearend. (Non Customer) 

1310900000 Accounts Receivable SD Recon Customer related Accounts Receivable 
1340000000 Interest Receivable  The amount of accrued interest 

receivable not otherwise identified. This 
account does not close at yearend.  
(Non Customer)  

1340900000 Interest Receivable Reco Customer related Interest Receivable  
1360000000 Penalties and Fines Receivable The amount of penalties and fines on 

receivables that is not otherwise 
identified. This account does not close at 
yearend.  (Non Customer) 

1360900000 Penalties and Fines Customer related Penalties and Fines  
1370000000 Administrative Fees Receivable  The amount of administrative fees 

receivable that is not otherwise identified. 
This account does not close at yearend. 
(Non Customer) 

1370900000 Administrative Fees Receivable-
Other 

Customer related Administrative Fees 
Receivable 

2310000000 Liability for Advances and 
Prepayments   

The amount of payments received in 
advance of performance of activities for 
which revenue has not been earned. 
This account does not close at yearend. 
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View a Billing Document 
 
Purpose 
Viewing a Billing Document in FMMI provides a process to verify information pertaining to the billing document, 
including payments (collections) posted to the billing document.  
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services billing and payment 
(collection) verification needs.   

 
Report Type 
NA 
 
FMMI Role 
Accounts Receivable, AR Evaluator 
 
Instructions 
STEP 1: Go to Accounts Receivable > AR Evaluation > Manage AR Documents > Display AR Document 
 

 
 
STEP 2: Enter the Bill Number (i.e. 3001150973) in the Document Number field and hit Enter.   
 

 
 

STEP 3: The following screen will appear which shows the billing document. 
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a. Note the following items: 
i. Clearing document number applied to the bill starts with __ signifies: 

1. 30 = bill was cancelled 
2. 24 = bill was paid with an IPAC payment 
3. 14 = bill was paid with a check, wire, ACH or plastic card 

 

 
 
b. Click on Display Document Header to show: 

i. Document Type 
ii. Entered by = FMMI User ID 

iii. Various Dates 
c. Click the green check box or the red X to close this screen 

 

 
 
 
STEP  4: Note the following payment details: 

a. Text Field –  
i. Check, Wire, ACH number 
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Multiple documents or cleared bill later than received = blank or one document number 
only 

ii. IPAC Document = blank 
b. Payment Reference Field – 

i. Check , Wire, ACH = the deposit ticket number 
ii. IPAC Document = IPAC Document Reference Number (DRN) – used to trace an IPAC 

payment   
 
STEP 5: To drill down into billing document , double click anywhere on the top line of the billing document 

 

 
 

The following screen will display.   

 
 

 
 
 
 
 
 
STEP 5: Go to Menu > Environment > Invoice Status and click on Invoice Status or press the Control Key and F10 
at the same time 
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STEP 6: The following screen will appear which lists all the payments (collections) applied to this particular billing 
document.  Note the following items: 

a. Green Dots = the bill has been paid in full by the payments applied to it = the bill is fully cleared 
b. Red Dots = the bill has not been paid in full by the payments applied to it = the bill is not fully 

cleared 
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STEP 7: To print this report as PDF click Menu > List > Print and go to step 8 (see step 9 to export to Excel). 
 

 
 

STEP 8: After Print is clicked, the following box will appear.  Click the green check and a PDF version will be 
available to print or save.   

 
 

STEP 9: To export to Excel, click Menu > List > Export > Spreadsheet 
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STEP 10: The following box will appear.  Enter the path and file name of your choice, and click Save.   
 

 
 

STEP 11:  An excel version will be available to sort, print, or save.   
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STEP 12: To save the file in Excel format, click File > Save As.  Name the file again and use the drop down arrow to 
to change the Save As Type to Excel Workbook, and click Save.   
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SO Reports 

Reimbursable Orders Report 
 
Purpose 
The Reimbursable Orders Report provides the overview of each Sales Order in FMMI.  This report shows the 
Contract End Date, SO Amount, Total Expenses, Total Billed, and SO Available Amount, among other fields.  The 
report is highly customizable to limit or expand the data you wish to see.   
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services SO verification needs.   
• This report does not reflect collections.   
• This report will not reflect transactions for your account which were posted incorrectly (ex. WBS 

FPDEFAULT).   
 
Report Type 
ECC 
 
FMMI Role 
Sales Order Reporter (Accounts Receivable, ECC) 
 
Instructions 
STEP 1: Go to 

1. Accounts Receivable 
2. Sales Order Reports 
3. Execute Sales Order Reports 
4. Reimbursable Orders Report 
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STEP  2: Enter the desired parameters in the variable entry screen to execute the report. 
 

 
STEP 3: To run by Fund, Fund Center, and Funded Program (WBS element), enter the following data: 

a. Business Area = AP00 
b. Fund = i.e. AP001600AR 
c. Fund Center = i.e. APWSWR4949 
d. Funded Program (WBS Element) = i.e. AP.RA.* 
e. Layout = /ZWSLAYOUT 
f. Click Execute to run the report 

 

 
 

STEP 4: The report will populate as shown below 
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STEP 5: Commonly Used Additional Features 

a. Save as Variant 
b. Filter 
c. Sort 
d. Subtotals 
e. Change Layout 

 
STEP 6: To print the report as PDF click Menu > List > Print and go to step 7 (See step 8 to export to Excel.) 
 

 
 
STEP 7: After Print is clicked, click the green check and a PDF version will be available to print or save. 
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*Note: first page of the report shows statistics about the report 
 
STEP 8: To export to Excel, click Local File:  
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STEP 9: The following box will appear, select Text with Tabs and click the Green Check Box. 
 

 
 
STEP 10: The following box will appear, use the drop down menu to select where you want to save the file, name 
the file, and click Generate 
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STEP 11: You may (or may not) receive the following security message.  If you get this message, click Yes. 
 

 
 

STEP 12: Your screen will return you back to the ROR.  A text file will be available in the directory you generated 
the report to. You will have to go to Excel, choose Open and change the File Type to “.txt” or Text File. A wizard 
will appear in Excel and you can click the Finish button. From there you can sort, print or save in the location you 
selected. 
 
STEP 13: You will have to go to Excel, choose Open and change the File Type to “.txt” or Text File. A wizard will 
appear in Excel and you can click the Finish button. From there you can sort, print or save in the location you 
selected. 
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STEP 14: After clicking “Finish” button on the import wizard, the file will open, as shown below. 
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STEP 15: Go to File >Save As, name the file again and use the drop down arrow to change the file type from 
Unicode Text to Excel Workbook, and click Save.  
 

 
 
 
STEP 16: You may have to fix some formatting in order to manipulate the data in Excel.  The following items will 
cause incorrect filter results in Excel: 

a. Not selecting the entire area that needs to be filtered 
b. Merged cells (header info) 
c. Inconsistent cell formats (Number, Text, Date, etc.) 
d. Entirely blank rows or columns 

 
*Note:  This layout (/ZWSLAYOUT) does not work with the Pivot Table you may have used in the past.  If you prefer 
that method, you may follow those instructions or choose the correct layout (/DEFAULT) to use the Pivot Table.   
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Budget 

APHIS AVC Budgets by Fund 
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AVC Tables 

Budget Availability Control 
 
Purpose 
The AVC Tables in FMMI provide budget availability balances.   
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services budget authority 
verification needs.  

• There are two version of this report:   
o 9H Control Ledger – Budget authority for all expenses, including the amount reserved for 

Overhead  
o ZR Control Ledger – Budget authority for direct expenses only, not including the amount reserved 

for Overhead 
 
Report Type 
ECC 
 
FMMI Role 
Funds Management, ECC Reporting 
 
Instructions 
STEP 1: Go to Funds Management > Reports > Budget Preparation and Planning > Budget Availability Control 

 

 
 
 

STEP 2: Variable entry screen will appear.  Enter the desired parameters to execute the report. 
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STEP 3: To run by WBS element and all budget availability, enter the following data: 
a. Control Ledger = i.e. 9H 
b. Funded Program (WBS Element) = i.e. AP.RA.NA32.71.0346 
c. Click Execute to run the report 
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STEP 4: The report will populate as shown below 
 

 
 
STEP 5: To expand the report to see a breakdown by BP, click on the right facing arrow next to the line 
 

 
 

STEP 6: Click on the right facing arrow next to the BP line you would like to examine 
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STEP 7: The report now shows as follows.  All Objects shows availability.    

a. Note the following items for the 9H Control Ledger:  
i. Consumable Amount represents the total amount of budget authority for the agreement, 

including indirect expenses (OH), for the BP. 
ii. Consumed Amount represents the total amount spent, including indirect expenses (OH), 

for the BP. 
iii. Available Amount represents the total amount remaining to be spent, including indirect 

expenses (OH), for the BP.    
 

 
 

STEP 8: Verification of Consumable Amount, Consumed Amount, and Available Amount can be done using Display 
Sales Order, LIACR Report, and Status of Funds, Project to Date Report respectively, see examples below.   
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STEP 9: To check the Control Ledger ZR version of the table, click on the Back button.   
 

 
 
STEP 10: In the Control Ledger field, change the selection to ZR and click Execute. 
 

 
 
STEP 11: The report will populate as shown below 
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STEP 12: To expand the report to see a breakdown by BP, click on the right facing arrow next to the line 
 

 
 

STEP 13: Click on the right facing arrow next to the BP line you would like to examine 
 

 
 
 
STEP 14: The report now shows as follows.  All Objects shows availability.    

a. Note the following items for the ZR Control Ledger:  
i. Consumable Amount represents the total amount of budget authority for the 

agreement, less indirect expenses, for the BP. 
ii. Consumed Amount represents the total amount spent, less indirect expenses and non-

reversed accruals, for the BP. 
iii. Available Amount represents the total amount remaining to be spent, less indirect 

expenses and non-reversed accruals, for the BP.    
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STEP 15: Verification of indirect costs consumed can be done using the Display SO (OH rate charged on the SO) 
and the LIACR Report (Eligible OH Expenses), see examples below.   
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Calculations 
9H Available Budget Authority     $27,411.00 
/ 1 + Overhead Rate                                  1.2715 
= ZR Available Budget Authority    $21,558.00 
 
9H Available Budget Authority    $27,411.00 
- ZR Available Budget Authority    $21,558.00 
Total Overhead to be Charged    $  5,853.00 
 
Total Overhead to be Charged    $  5,853.00 
- Total Overhead Charged    $  4,745.11 
Uncharged Overhead     $  1,107.89 
 
Indirect Cost Allocation (Based on $5,853.00 total) 
WS indirect 11% = $21,558.00 * .11 = $2,371.38 
WS pool 11% = $21,558.00 * .11 = $2,371.38 
PM 5.15% = $21,558.00 * .0515 = $1,110.24 
 
Findings for this example – Overhead is undercharged on this WBS and BP, based on eligible expenses. 
Period 2 OH is missing, period 11 OH is missing, and Period 12 OH is duplicated.    
 

 
 
STEP 16: Additional Items to Note: 

 
a. Over budget icon – may relate to any transaction(s) associated with the WBS and BP.   
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Status of Funds Project-to-Date Report 
 
Purpose 
The Status of Funds (SOF) Project-to-Date (PTD) Report provides high level budget availability.  The report is 
customizable to limit or expand the data you wish to see, after the report is generated. 
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services SOF needs.  
• This report only provides a high level overview; it does not provide details at the transaction level.   
• Due to an error in the report, you must remove the Commitment Item 4610YE0000, after the report has 

been generated, to obtain accurate results.   
 
Report Type 
BI 
 
FMMI Role 
General Ledger Management, BI Reporting 
 
STEP 1: Go to General Ledger Management > BI General Ledger Reports > Status of Funds Project-to-Date   
 

 
 

STEP 2: Variable screen entry for report will appear.  Enter the desired parameters to execute the report.   
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STEP 3: To run by Fund, enter the following data: 

a. Fiscal Year = i.e. 2015 (use current fiscal year to get current results) 
b. From Period = 1 (October) – should always be from Period 1 to capture the activity from the 

beginning of the Fiscal Year 
c. To Period = i.e. 12 (September) – the ending period of the report 
d. Fund = i.e. AP001600AR (RA) 
e. Fund Center = i.e. APWSER55555 
f. Optional: click check and if search criteria was entered correctly, a description will appear in the 

Description column 
g. Click OK to run the report 

 

 
 

STEP 4: The Report will display as shown below 
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STEP 5: Open layout by clicking on Open > /WS RMVD 4610YE > OK   
(This layout has been saved to remove Comm Item 4610YE) 

 

 
 
*NOTE:  You must remove the Commitment Item (BOC) 4610YE0000 to get the accurate balance.  The reason is that 
the budget group entered a year end adjustment our first year in FMMI which was posted in a non-reporting month 
(i.e. 16) but reversed in a reporting month (i.e. 01).  Since the reversal posted in a real fiscal month the balances are 
skewed.  To remove this item from the report without using the above layout, follow these steps:  Click on Filter > 
Go to Commitment Item > Select Edit > Click on Select All > Deselect 4610YE0000 > Click Add > Click Okay.   

 
STEP 6: Using the above mentioned layout, the report will now display as shown below.   
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STEP 7: Commonly Used Additional Features  
a. Drag and Drop 
b. Filter 
c. Filter > Variable Screen 
d. Subtotals 
e. Save As / Open (Layout) 

 
STEP 8: To print the report as PDF, click Print Version and go to step 9 OR to export to Excel, hold down the CTRL 
key and click Export to Microsoft Excel and go to step 10.  Continue to hold the CTRL key down until the report 
shows in Excel. 

 

 
 

STEP 9: After Print Version is clicked, the following box will appear, click OK 
 

   
 

STEP 10: After Export to Excel is clicked, the following box will appear, click Open 
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STEP 11: Click Yes and the report will automatically open in Microsoft Excel 
 

 
 

STEP 12: To enable editing, click the box Enable Editing shown 
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Over Budget Issues 
 

Common Over Budget Issues 
 

• Cannot post additional expenses 
o OH (indirect expenses) will not post 
o Direct expenses will not post 

 

• Cannot close SO or associated master data elements  
 

Reasons and Resolutions for Over Budget Issues (“Budget Exceeded” errors) 
 

• SO BP line amount has been reduced (check Display SO, Doc Flow, and/or manually recalculate AVC 
Tables) 

o Request change of SO BP line amount through SharePoint or email to 
MRP.Billing.Requests@usda.gov (where justified) 
 

• Expenses overspent or posted to wrong account (check ROR, manually recalculate ZR AVC Tables, LIACR 
and/or Payroll Detail Report) 

o Modification of Agreement, Expenditure Adjustment for direct expenses, or Request Additional 
Collection(s), as warranted 
 

• OH (indirect expenses) overspent (can be any associated OH account) (manually recalculate ZR AVC Table, 
check LIACR and/or SOF PTD) 

o Expenditure Adjustment for indirect expenses 
 

• Open Unneeded Obligations absorbing budget (check ULO or SOF PTD) 
o Deobligate unnecessary open obligations 

 

• Accruals not reversed 
o Follow up on non-reversed accruals 

 

• ROWA, additional reasons/resolutions: 
o Collection not received (check Doc Flow, ROR, and/or Daily Collections) 

 Request collection from customer 
o Collection not cleared (check Doc Flow and/or ROR) 

 Follow up on why it is uncleared, as needed, with ABSHelpline@usda.gov  or 
MRP.Billing.Requests@usda.gov   

o Collection not posted properly (check Doc Flow, ROR, and/or Daily Collections) 
 Follow up with ABSHelpline@usda.gov  for a collection modification 

o Additional uncleared, unnecessary DPRs (check Doc Flow and ROR) 
 Follow up with MRP.Billing.Requests@usda.gov if there are any additional uncleared, 

unnecessary DPRs 
 

• INTR – Intra-agency – USDA, additional reasons/resolutions: 
o PO not entered, not approved (i.e. parked), or increased to appropriate funding 
o Second line was created on PO rather than increasing the first line 

 Contact IOAT@usda.gov for assistance on INTR PO issues 

mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:Lucy.A.Currie@aphis.usda.gov
mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:Lucy.A.Currie@aphis.usda.gov
mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:IOAT@usda.gov
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*NOTE:  If over budget issues prevented OH from posting in a prior period, after you have resolved the over 
budget issue(s), you will need to send a request to MRP.Billing.Requests@usda.gov to rerun OH for the prior 
period(s) missed. 
 

Example - Over Budget Issue on OH Account 
 

When sales orders are established, a portion from each SO is set aside into the overhead pot of funds.  The 
“budget” in the overhead pot of money that was created by the sales orders can be seen, however you don’t 
actually have those funds until expenses are posted and the overhead is generated and “earned.”  When billings 
staff tries to reduce a sales order and there are more expenses posted to the overhead WBS than was earned, 
they will get a “budget exceeded overhead ledger” error.    
 
For example prior to fiscal year 2016, if there are four sales orders with the amounts below 
 

 Direct expense portion overhead portion total SO amount 
SO 1 $9,000.00 $1,000.00 $10,000.00 
SO 2 $8,000.00 $900.00 $8,900.00 
SO 3 $15,000.00 $1,500.00 $16,500.00 
SO 4 $7,000.00 $700.00 $7,700.00 

    
total $39,000.00 $4,100.00 $43,100.00 

 
You should see a “budget” of $4100 in the overhead pot of funds.     
 
Then at some point, one SO is reduced in amount for any reason: 
 

 Direct expense portion overhead portion total SO amount 
SO 1 $7,200.00 $800.00 $8,000.00 
SO 2 $8,000.00 $900.00 $8,900.00 
SO 3 $15,000.00 $1,500.00 $16,500.00 
SO 4 $7,000.00 $700.00 $7,700.00 

    
total $37,200.00 $3,900.00 $41,100.00 

 
Now there is only a “budget” of $3900.   If more expenses are posted to the overhead WBS than that $3900, 
billings staff will get a budget exceeded error.    Because there are more expenses on that overhead WBS than 
that $3900 they will be unable to reduce the sales order.     In the above example, if there were $4100 in expenses 
posted to the overhead WBS, billings staff would receive a “budget exceeded overhead ledger” of $200.     
 
For fiscal years 2016 and after, FMMI still would reserve a portion of the sales orders total amount for overhead, 
but you won’t have a budget authority on your overhead WBS elements until overhead jobs are run.  Once 
overhead is run, you would be able to post expenses to it.  If you spend all the available budget on a budget 
period, then the AVC table would show a zero available balance.   If there is a zero available balance and expenses 
are removed from a sales order with a budget period that has a zero available balance, then the negative 
overhead will not generate.  Also, if the negative overhead that would generated is greater than the available 
balance, then negative overhead would not generate.    

mailto:MRP.Billing.Requests@aphis.usda.gov
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In the example below, the budget period 1717 shows a zero available balance so no negative overhead can be 
generated.   On budget period 17XX has an available balance, but if by some change the negative overhead would 
exceed the amount shown, then again the negative overhead would not generate.   
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Unliquidated Obligations (ULO)  

Overview 
 

Purpose 
The APHIS ULO process is the process APHIS uses to manage and report on unliquidated obligations.  Unliquidated 
obligations over 12 months of no activity require justification.   
 
Obligations do affect budget availability.  It is important to clean these up as soon as reasonably possible.   
 
Anyone that has responsibility for the ULO review and certification should have access to the U Drive for 
additional ULO information and instructions.  Anyone who is responsible for the ULO review and certification but 
does not have access to the U drive should contact Naomi Yang, the APHIS ULO lead.   
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FMMI HANA Unliquidated Obligations (ULO) Report 
Purpose 
The ULO Report provides details on unliquidated obligations.  This report will display obligations document details 
including vendor, days since last activity, years old, and amount.   
 
Considerations 

a. User must have access to FMMI HANA reports 
 

Report Type 
HANA report 
 
Role 
Ad hoc Analysis, BOBJ Ad Hoc Analysis 
 
Instructions 
STEP 1: Go to Ad-hoc Analysis > BOBJ Ad-hoc Analysis 
 

 
 
 

STEP 2: A new browser tab will open.  Navigate to the “See more...” links found in the right most quadrants on the 
Ad-hoc Analysis dashboard. 
 

 

Nguyen, Kyle V - APHIS
12 month ULO report deleted - need to also delete from table of contents.

Nguyen, Kyle V - APHIS
Need better screenshots from Donna for this section.
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STEP 3: Navigate to the desired HANA ULO Report:  

1) Folders 
2) Public Folders 
3) FMMI 
4) Ad-Hoc Reporting 
5) APHIS 
6) General Ledger Reports 
7) ULO 

 

 
 

a. HANA-Unliquidated Obligations_AP00_12MONOACTIVITY (see step 5a) 
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• Recommended to use when reviewing ULO report with 12 months of no activity  
b. HANA-Unliquidated Obligation_AP00_Detail 

• Recommended to use when reviewing the ULO summary report  
c. HANA-Unliquidated Obligations_AP00_MONTHLY 

• Recommended to use when preparing the monthly ULO report    

 

 
 
STEP 4:  A window prompt will appear, enter the specific accounting elements to narrow down search results. The 

data may be searched (  ) or typed but must be moved to the right side of the box to be included (Fields with * 
symbol indicate a required field)  

*Business Area: AP00  

*Key Date: YYYYMMDD (through date – example: 20190531) 

*Open/Closed Flag: OPEN 
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Notes: Use the fields with “F”, for example use Funds Center instead of Cost Center. Use Funded Program instead 
of WBS. 

Hold Ctrl+ Left Mouse Click to select individual data 

 
 
Hold Shift+Left Mouse Click to select range of data 
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STEP 5: To export the HANA report, press the (   ) icon on the left side menu 

 

Choose a file type, press OK (Excel is recommended).  A prompt box may appear – select “open”. 
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NOTE: Ad-Hoc reports are made available to multiple users do not Save the report. Select “Save As” to save in 
your favorite folder before editing in Design mode. 

STEP 5a:  This extra step is specific to the HANA-Unliquidated Obligations_AP00_12MONOACTIVITY only. Change 
to Design Mode, right click on “LAST ACTIVITY DATE” column and select “Filter”. 

 

 

Search for Last Activity Date (MMDDYYYY), press arrow to select and press OK to update report.  The Last Activity 
Date represents the date the document was last updated with a payment or adjustment. 
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Request Collection Modification 
 
Purpose 
Collection Modifications are an adjustment process used to recode the customer and/or master data elements 
assigned to a particular collection transaction.   
 
Instructions 
STEP 1: Email request to ABSHelpline@usda.gov.  Email should include: 

a. Subject – “Collection Modification Request – Doc Number 1200001234 - $250.00” 
b. Body – include the following:   

i. Incorrect Collection Posting Document Number (i.e., 1200001234) 
1. See Daily Collections for detailed instructions.  Document numbers for collection 

postings are 10 digit numbers beginning with 12, 13, or 14. 
ii. Justification for Request (i.e., Should be Advance Collection) 

iii. Correct Posting Information: 
1. WS Customer Type (i.e., Advance, Reimbursable, or OTC) 
2. Customer Number (i.e., 3301234) 
3. WBS Element  (i.e., AP.RA.xxxx.xx.xxxx) 
4. BP (i.e., 14XX) 
5. Amount (i.e., $250.00) 

 
Example 

 
 

mailto:Lucy.A.Currie@aphis.usda.gov
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Request Customer Refund 
 
Purpose 
Customer refunds are a process used to refund the remaining balance on a customer account after services are 
completed and all financial transactions have posted to the account.   
 
Instructions 
STEP 1: Email request to ABSHelpline@usda.gov.  Email should include: 

c. Subject – “Customer Refund Request – Cust. No. 3301234 - $565.25” 
d. Attachment – Completed Request for Customer Refund Form 

 

  

mailto:Lucy.A.Currie@aphis.usda.gov
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Debt Management 
 

Process 
When payment of a bill is not received within 30 days of issuance, the debt is considered past due and a process is 
initiated within FMMI and APHIS to collect that money.  The following is a timeline of the debt management 
process. 
 
Day 1 – This is the Bill date, bill is sent to the customer,    A Notice of Intent to Refer to U.S. Treasury is included. 
 
Day 30 – Bill payment is due. 
 
(Day 31 – FMMI automatically generates the first past due notice and sends it to the cooperator. This notice is a 
reminder that the debt is now due.  No interest or penalty is recorded on the notice.  However, this is the day 
interest begins to be assessed.  In 2014, interest is 1% per annum.  The interest rate is mandated by U.S. 
Treasury.)  NOTE:  FMMI is not currently set up to have past due notices, interest, or penalties automatically 
generate.  This will occur in the future… 
 
(Day 60 – FMMI automatically generates the second past due notice and sends it to the cooperator.  This notice 
states that the debt is now 30 days past due.  Interest charges are recorded on this notice.)  NOTE:  FMMI is not 
currently set up to have past due notices, interest, or penalties automatically generate.  This will occur in the 
future… 
 
Day 75 – The debt is now 45 days past due.  An Accounts Receivable specialist will contact the cooperator 
requesting payment. 
 
(Day 90 – FMMI automatically generates the third past due notice and sends it to the cooperator.  The notice 
states the debt is now 60 days past due and current interest charges are recorded.  A Notice of Intent to Refer to 
U.S. Treasury is included.  An Accounts Receivable specialist will send a letter to the cooperator reminding them 
that the debt is due.)  NOTE:  FMMI is not currently set up to have past due notices, interest, or penalties 
automatically generate.  This will occur in the future… 
 
(Day 91 – Penalty charges are now assessed.  The charges are retroactive to the due date.  Per U.S. Treasury 
regulations, the penalty is 6% per annum.)  NOTE:  FMMI is not currently set up to have past due notices, interest, 
or penalties automatically generate.  This will occur in the future… 
 
Day 120 – The debt is now 90 days past due.  If there has been no response to the letter sent on Day 90, an 
Accounts Receivable specialist will telephone the cooperator to request payment.  The specialist will also call the 
WS office to inform WS of the status of the collection procedure.  If the cooperator is not paying, the specialist will 
advise that services to the cooperator maybe suspended.   
 
Day 150 – The debt is now 120 days past due.  The debt will have been referred to U.S. Treasury for cross 
servicing prior to this date.  
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APHIS issues Bill or Statement 

Open receivable created in FMMI 

First Past Due Notice sent on collection due date 

Second Past Due Notice sent 30 days after first notice 

Interest assessed 31 days past collection due date 

Contact vendor; debt is 45 days old –by phone/letter 

Third Past Due Notice sent 30 days after second notice 

Interest assessed 61 days past collection due date 

DMT sends letter  

Interest and penalty assessed 91 days past due 

No payment 

No payment 

No payment 

No payment 

No payment 

Debt referred to Treasury for cross-
servicing 120 days past due 

DMT sends letter 

Debt Management Process Flow Chart 
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Debt Management Regulations 
 

Regulation References: 
Debt Collection Improvement Act of 1996 
Public Law 104-134 
Seven purposes: 

1. To maximize collections of delinquent debts owed to the Government by ensuring quick action to enforce 
recovery of debts and the use of all appropriate collection tools. 

2. Minimize the costs of debt collection by consolidating related functions and activities and utilizing 
interagency teams. 

3. To reduce losses arising from debt management activities by requiring proper screening of potential 
borrowers, aggressive monitoring of all accounts and sharing of information within and among Federal 
agencies. 

4. To ensure that the public is fully informed of the Federal Government’s debt collection policies and that 
debtors are cognizant of their obligations to repay amounts owed to the Federal Government. 

5. To ensure that debtors have all appropriate due process rights, including the ability to verify, challenge 
and compromise claims and access to administrative appeals procedures which are both reasonable and 
protect the interest of the United States. 

6. To encourage agencies, when appropriate to sell delinquent debt, particularly debts with underlying 
collateral 

7. To rely on the experience and expertise of private sector professionals to provide debt collection services 
to Federal agencies. 

 
This law provides that any non-tax debt or claim owed to the United States that has been delinquent for a period 
of 180 days shall be turned over to the Secretary of the Treasury for appropriate action to collect or terminate 
collection actions on the debt or claim. 
 
31 USC 7701 
The head of each Federal agency shall require each person doing business with that agency to furnish to that 
agency such person’s taxpayer identification number.  A person shall be considered to be doing business with a 
Federal agency if the person is in a relationship with the agency that may give rise to a receivable due to that 
agency. 
 
7 CFR 3.34 (USDA Debt Management) 
USDA creditor agencies must attempt to collect interest, penalties and administrative costs on any delinquent 
debt owed to the U.S. in accordance with 31 CFR 901.9, or according to written documentation constituting the 
basis of the debt, or under any guidelines issued by the Assistant Secretary for Administration or by the creditor 
agency’s fiscal officer.    Agencies will assess a penalty of 6% a year on any unpaid debt balance delinquent for 
more than 90 days.  
 
Separation of Duties for Collection Officer: 
GAO Policy and Procedures Manual for Guidance of Federal Agencies.   Title 7 Fiscal 
Procedures, Chapter 5.2B Control over Collections – Separation of Duties for Cash 
Receipts:   
In accordance with the internal control standard for separation of duties, persons responsible for handling cash 
receipts should not participate in the accounting or operating functions relating to any of the following: 

1.   Shipping of goods and billing for goods and services. 
2. Controlling accounts receivable and subsidiary ledgers. 
3. Preparing and mailing statements of balances due. 
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4. Authorizing and approving credits for returns and allowances or adjustments of amounts due. 
5. Preparing cash reconciliations. 

 
Federal Claims Collection Standards (FCCS) – Dept of Treasury & Justice 
 
31 CFR 901.1 Aggressive agency collection activities 
Federal agencies shall aggressively collect all debts arising out of activities of that agency.  Collection activities 
shall be undertaken promptly with follow-up action taken as necessary. 
 
31 CFR 901.2 Demand for Payment 
Written demand informing the debtor of basis for indebtedness and rights of the debtor; standards for imposing 
any interest, penalties or administrative costs; date by which payment should be made to avoid late charges and 
enforced collection; and agency contact person or office shall be made promptly upon a debtor of the U.S. in 
terms that inform the debtor of the consequences of failing to cooperate with the agency to resolve the debt.  
The FCCS states that generally one demand notice should suffice but USDA has established the use of 3 demand 
notices in its financial system. 
 
31 CFR 901.6 Suspension or revocation of eligibility for loans and loan guaranties, licenses, 
permits, or privileges. 
In non-bankruptcy cases, agencies seeking the collection of claims should consider the suspension or revocation 
of licenses, permits, or other privileges for any inexcusable or willful failure of a debtor to pay such a debt in 
accordance with the agency’s regulations or governing procedures. 
 
31 CFR 901.9 Interest, penalties, and administrative costs 
Agencies shall charge interest, penalties and administrative costs on debts owed to the U.S. pursuant to 31 USC 
3717.   An agency shall mail or hand-deliver a written notice to the debtor, at the debtor’s most recent address 
available to the agency, explaining the agency’s requirements concerning these charges.  Agencies shall charge a 
penalty, pursuant to 31 USC 3717(e)(2), not to exceed 6% a year on the amount due on a debt that is delinquent 
for more than 90 days. 
 
31 CFR 902.2 Basis for Compromise 
Agencies may compromise a debt if the Government cannot collect the full amount because:  (1) The debtor is 
unable to pay the full amount in a reasonable time, as verified through credit reports or other financial 
information; (2) The Government is unable to collect the debt in full within a reasonable time by enforced 
collection proceedings; (3) The cost of collecting the debt does not justify the enforced collection of the full 
amount; (4) There is significant doubt concerning the Government’s ability to prove its case in court. 
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RRB Bill Format 
 

 



  

Page 149 of 216 
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APHIS Completed Form W-9 
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The ABS Helpline 
 

PHONE:  612-336-3400 or 877-777-2128 

ABS Helpline is a toll free number that any customer can call when they have questions regarding their USDA 
customer account.  This phone number is listed on all of our dunning notices, past due letters, and monthly 
statements.  This line has a recorded message instructing callers to leave their name, phone number, customer 
account number and brief message.  The voicemail messages are picked up by members of the APHIS and Non-
APHIS Account Receivable team members.  The messages are written up and distributed to the correct FMD 
employee that handles the customer account.   

EMAIL:  ABSHELPLINE@USDA.APHIS.GOV    

Emailing the ABS Helpline is another method for our customers to contact us about their account or bill questions.  
All staff members of the APHIS and Non-APHIS Accounts Receivable teams check the email helpline on a regular, 
hourly basis.  The messages are typed up and sent to the proper staff person in FOB.  Customers with the sales 
office of WILD are given to ABS Helpline in the Minneapolis office. 

If a customer requests the backup documentation for a Wildlife Services bill, ABS Helpline will forward the 
message to the state office. 

Both the voicemail and email ABS Helplines are answered by Minneapolis Financial Operations Branch. 

 
 
 
 

mailto:ABSHELPLINE@USDA.APHIS.GOV


  

Page 152 of 216 
 

Close Sales Order 

Zero Dollar Balance 
 
Instructions 

1. Ensure all collections and expenses are posted correctly (see Daily Collections and LIACR for detailed 
instructions) 
 

2. Verify OH was captured on all periods with expenses (see LIACR and HANA – SO OH Reconciliation for 
detailed instructions 
 

3. Verify All Expenses Have Been Billed (see ROR for detailed instructions) 
 

4. Request SO Line Amount be Reduced to Consumed Amount (see ROR for detailed instructions) 
a. Email to MRP.Billing.Requests@usda.gov 

 
5. Ensure Zero Balance (see SOF PTD for detailed instructions) 

a. Advance SO – Request Refund if needed (see Refund Request for detailed instructions) 
i. Email to Jennifer.L.Elias@usda.gov 

 
6. Reconcile Account Zero Balance (WBS and BP = SO Line Item) (see SOF PTD for detailed instructions) 

 
7. Check Doc Flow for any uncleared items (see View a SO, Doc Flow, or HANA – APHIS GL plus AR Sales 

Order Document for detailed instructions) 
a. Research and resolve any uncleared items – contact appropriate party by doc type (i.e. RV doc 

contact Billing group) 
 

8. Request to manually clear customer line items, F32 (see Customer Line Item Display for detailed 
instructions) 

a. Email to ABSHelpline@usda.gov 
 

Request Close of Shorthand Codes  
 
Purpose 
Closing SHCs prevents further activity from posting to those SHCs.   
 
Considerations 

• SHCs for projects that are not complete SHOULD NOT be closed.   
• MASC must remain active for at least one year to allow documents such as a corrected T&A and PROP 

depreciation to process through. 
• Closing SHCs in FMMI does not remove the code from the feeder system.  That process is individual to 

each feeder system.  For WebTA timekeepers can remove SHCs.   
 
Instructions 

mailto:MRP.Billing.Requests@aphis.usda.gov
mailto:Jennifer.L.Elias@aphis.usda.gov
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1. Designated program staff should send an email to APHIS-Master Data Requests 
(Master.Data.Requests@usda.gov) with the list of SHCs to be deactivated (no reference to feeder systems 
needed).   

2. The lists will be submitted to NFC for processing, deactivating the SHC from all feeders except MASC. 

mailto:Master.Data.Requests@aphis.usda.gov
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Shorthand Code Close Verification 
 
Purpose 
To verify if a SHC request for (activation or) deactivation has been successfully completed in FMMI.   
 
FMMI Role 
Interface Table Maintenance Evaluator 
 
Instructions 
STEP 1: Go to Interface Table Maintenance 
STEP 2:  Go To Shorthand Code Table 
STEP 3:  Go To View Shorthand Code  
STEP 4:  Type 34 (APHIS) in the Agency field 
Step 5:  Type your WBS in the WBS Element field 
STEP 6: Click on the Execute button 
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STEP 7: The report will populate as shown below 
a. Note the following items: 

i. Sys ID 
ii. Status 

1. Active = Open 
2. Deactivated = Closed 

 
 
 

Request Close of WBS Elements (Where Applicable) 
Purpose 
Closing WBS Elements prevents further activity from posting to those WBS Elements.  
 
Considerations 

• WBS Elements for projects that are not complete or that will be reused on future projects SHOULD NOT 
be closed.   

 
Instructions 
Designated program staff should send an email to APHIS-Master Data Requests 
(Master.Data.Requests@usda.gov), stating that the code will no longer be needed, the account balance is zero, 
and the account has been fully reconciled.   
 

WBS Elements Close Verification (Where Applicable) 
 
Purpose 
To verify if a WBS Elements’ request for deactivation has been successfully completed in FMMI.   
 
FMMI Role 
Cost Management Evaluator 
 
Instructions 
STEP 1: Go to Cost Management  
STEP 2:  Go to Display Project  
STEP 3:  Go to Project Builder  
 

mailto:Master.Data.Requests@aphis.usda.gov
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STEP 4: To search by WBS go to Menu > Project > Open 
 

 
 
The following screen will appear.  Enter the following: 
 
STEP 5:  Type in WBS Element – i.e. AP.TF.VSCV.19.0098 
STEP 6: Click the green check box to execute 

 

 
 
The report will populate as shown below.  Note the following items: 

a. System Status 
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b. REL ACPT = Open 
c. CLSD or CLSD ACPT = Closed 
d. REL LCKD-ALL = Locked (okay to use when minor error prevents Close status) 
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Customer Line Item Display 
 
Purpose 
The Customer Line Item Display provides a process to verify information pertaining to the customer account and 
respective SO, including identifying items that are not fully cleared and preventing the SO from closing.  
 
Considerations 

• These instructions were specifically tailored to accommodate Wildlife Services SO close needs.   
 
Report Type 
ECC 
 
FMMI Role 
Accounts Receivable, AR Evaluator Role 
 
Instructions 
STEP 1: Go to  

1. Accounts Receivable 
2. AR Evaluation 
3. Manage AR Documents 
4. Display Account Balance for AR Items 

 

 
 
STEP 2: To review the customer account, enter the following data: 

a. Customer account = i.e. 3365613 
b. Status = All Items 
c. Type = check all boxes 
d. Layout = /WS UNCLEARD 
e. Click Execute 
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STEP 3: The following screen will appear which lists all the bills and collections applied to this particular customer  
 account.  Note the following items: 

a. Green Dots = the bill has been paid in full by the payments applied to it = the bill is fully cleared 
b. Red Dots = the bill has not been paid in full by the payments applied to it = the bill is not fully 

cleared 
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STEP 4: In regards to closing a SO, you need to ensure all items affecting the SO are completely cleared.  In the 
example above that is simply showing a collection not yet applied to a bill.  No action is necessary in this example 
as the account is not ready to be closed and it will clear on its own once the next RRB bill is produced and FIFO is 
run.   

 
STEP 5: If this were a real example of an account you were trying to close and there were true uncleared items 
(aka system errors), you would need to do the following steps: 

a. Determine which items need to be manually cleared to close the SO.  These must be: 
i. Only the items related to the SO you are trying to close.   

ii. Balanced to zero dollars.   
b. Send an email to ABSHelpline@usda.gov asking for a F-32 manually clearing.  Example below.   

 

 

mailto:ABSHelpline@usda.gov
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FMMI Posting Keys (PK) 
 

Posting keys are two-digit numerical keys that control the entry of line items.  Posting keys are differentiated by 
customer, vendor and G/L accounts.  

SAP delivers predefined posting keys with the standard system. Additional posting keys were created for FMMI.   

FMMI Posting Keys  
(bold = common APHIS AR PKs) 

Posting Key Description 

00 Act assignment model 

01 Customer invoice 

02 Reverse Credit Memo 

03 Expenses 

04 Other receivables 

05 Outgoing payment 

06 Payment difference 

07 Other clearing 

08 Payment clearing 

09 Special G/L debit 

11 Customer credit memo 

12 Reverse invoice 

13 Reverse charges 
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14 Other payables 

15 Incoming payment 

16 Payment difference 

17 Other clearing 

18 Payment clearing 

19 Special G/L credit 

21 Vendor credit memo 

22 Reverse invoice 

25 Vendor payment 

31 Vendor invoice 

32 Reverse credit memo 

34 Other payables 

35 Incoming payment 

36 Payment differences 

37 Other clearing 

38 Payment clearing 

39 Special G/L credit 

40 G/L account debit posting 
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50 G/L account credit posting 

70 Debit asset 

75 Credit entry 

80 Stock initial entry 

81 Costs 

83 Price difference 

84 Consumption 

85 Change in stock 

86 GR/IR debit 

89 Stock inward movement 

90 Stock initial entry 

91 Costs 

93 Price difference 

94 Consumption 

95 Change in stock 

96 GR/IR credit 

99 Stock outward 

0A CH bill doc debit 
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0B CH cancel credit memo debit 

0C CH clearing debit 

0X CH clearing credit 

0Y CH credit memo credit 

0Z CH cancel bill doc debit 

1A CH cancel bill doc debit 

1B CH credit memo debit 

1C CH credit memo debit 

1X CH clearing credit 

1Y CH cancel credit memo credit 

1Z CH bill doc credit 
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FMMI Tips and Tricks 
 

General (applies throughout FMMI) 
 

FMMI Screen Layout 
 
Header Area - Does not change when the user navigates from one page to another. Includes Top-level 
Navigation 

 
Top Level Navigation Ribbon and Tabs - Displays the entry point for navigation using the content 
which is assigned to the user 

 

• First-level tabs display the process areas e.g., Accounts Receivable 
• Second-level tabs display the FMMI roles e.g., Sales Order Processor 
• The menu is different depending on users role(s) 
• A role matches the user’s specific tasks and information needs and is linked to FMMI login 

 
Content Area - Includes: Title Bar, Application Toolbar, Screen Body, and Status Bar. However, content 
available, selections, and icons differ depending on the selected transaction 
 
Navigation Panel Displays - The Navigation Panel is located on the left side of the screen and is divided 
into the following areas: Detailed Navigation and Portal Favorites 
 
Help Button - Access to Job Aids (some may be for other agencies) 
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Back Button 
 
Back button - Do not use the browser or ribbon Back button.  Only use the Back button within each report or task, 
if available. 
 

 
 

Required Fields 
 
In the variable entry screens, only the fields with asterisk (*) within the field are required fields to run the 
report.  The more fields you complete, the quicker you will obtain results and the more limited the data returned 
will be.   
 
 

Wildcard 
 
The asterisk (*) can be used in any FMMI report or task as a wildcard.  It can be used before, after, or in the 
middle of items. The wildcard asterisk (*) can represent an indefinite amount of consecutive characters, therefore 
multiple consecutive asterisks are not necessary.  Some examples: 

• AP.*.0121 
• AP.*.*36 
• AP.RA.OVHD.* 
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myPortal Favorites – Add Report or Task 
 
You can save your FMMI Favorites as shortcuts on the left margin in FMMI. 

• Using the Top Level Navigation ribbon, navigate to the FMMI task you want to save.   
• On the right, Click on the PAPER ICON. 
• This will show a list of options.  Select ADD TO PORTAL FAVORITES. 
• Note that your report or task is now listed on the left side of the screen under MYPORTAL FAVORITES. 

Now you can avoid the ribbon navigation and just click on your frequently used tasks.  
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myPortal Favorites – Organizing Entries 
 
You can organize your reports and tasks under myPortal Favorites, options include: 

• Renaming  
• Deleting  
• Creating folders 
• Moving 

 

 
 
 
 
Creating New Folders -  
 



  

Page 169 of 216 
 

 
 
 
Moving Favorited shortcuts -  
 

 
 
After selecting Move... you will be redirected to the following screen:  
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 Dynamic Selections 
 
Dynamic selections are a way to enhance report selection criteria prior to running the report with variables not 
contained on the variable entries screen.   
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Save Variant 
 

Saving variants allow users to run their typical reports without having to re-enter all of the variables each time.  
Simply enter the variables you wish to use and click on “Save As Variant…”.  Users can make changes to the 
variables and/or resave the variant before running the report. 
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Variants saved with a “/” before the name are public variants (i.e. /WS xxxx).  Variants without a “/” before the 
name are private variants (i.e. WS xxxx). 
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Open/Select Variant 
 

Opening/selecting a variant allow users to run their typical reports without having to re-enter all of the variables 
each time.  Simply select the variant you wish to use.  This will populate the variable entry screen with pre-defined 
variables.  Users can make changes to the variables and/or resave the variant before running the report.   
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Determining the Level of Customization of a Report 
 

Users can determine the level of customization of a FMMI report or task, to a decent degree, by reviewing the 
Transaction Code associated with the report or task.  Simply view the Transaction Code associated with the report 
or task and google it (i.e. google “SAP CJI3”).  Standard SAP functionality runs off of these Transaction Codes and if 
your search provides a conclusive SAP answer (i.e. SAP CJI3 = Project Actual Cost Line Items), it is a standard 
report or task.  If not, the report has been designed by the USDA. 
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ECC Reporting (applies to ECC Reports) 
 

Multiple Selections 
 
Multiple selections allow users to include or exclude specific multiple selections.   
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General  
 
ECC reports are highly customizable to limit or expand the data you wish to see, options include: 

• All of the General Tips and Tricks above, plus… 
• Drill down capabilities (double click on document number to open document, often underlined) 

o Display Document Header 
• Select Layout  
• Change Layout 

o Displayed Columns 
o Sort 
o Subtotals 
o Filter 

• Save Layout 
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HANA AD-Hoc Reporting 
 

Navigating to Ad-Hoc Reporting in FMMI: 
On the first tier navigation bar, click the link named “Ad-hoc Analysis”: 

 

 

After clicking on the “Ad-hoc Analysis” link a new tab in Internet Explorer will open which will show the Ad-hoc 
Analysis dashboard: 
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Opening an existing Accounts Receivable report: 
 Click the “See more…” link on the dashboard located on the two right most quadrants: 

 

Next, click on the Folders bar found on the bottom left of the screen: 
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After clicking on the Folders bar, navigate to the Accounts Receivable folder: 

1. Public Folders 
2. FMMI 
3. Ad-Hoc Reporting 
4. APHIS 
5. Accounts Receivable 
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HANA Prompt Screens: 
Most of the HANA reports have been designed to prompt the user to provide information to narrow the 
search/query and provide the information based on the criteria you select.  These prompt screens vary from 
report to report but the basic ideas of inputting of information remains the same.  You should be familiar with 
navigating this screen and changing the criteria. 

 

 

Two arrows in the center or the Selection Arrows allow you to: 

• Add a value (the right pointing arrow) 
• Delete a value (the left pointing arrow) 

After the report runs, if you need to change the criteria, you will have to click the Refresh button and a new 
prompt screen will appear: 

 



  

Page 182 of 216 
 

 

Saving the report: 
If you modify the report in any way (changing columns or User Prompt Input), please save the report to your 
Favorites folder by clicking the little black down arrow button next to the Save icon as shown by the blue arrow: 
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Exporting the report to Excel: 
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Report Design: 
 

There are about 4 main reports that can be manipulated to get the information you are looking 
for. These reports are: 

1. Federal Transaction Register Detail 
2. Spending Detail 
3. Sales Order History 
4. Reimbursable Billing Document 

There are other reports that can be manipulated but the ones listed above are the most 
frequently used. 

 

To manipulate a report, you have to click on the Design button found on the top right. 

 

 

 

 

To view the available fields that can be pulled into the report, click on the Available Objects 
button on the left hand side of the screen: 
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The Available Objects are being pulled from a “Universe” of many fields in FMMI. If you do not 
see the field you want, than you can look to see if it is available in the “Universe” where the 
information is being pulled from.  You need to click on the Data Access tab and then Edit button. 
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Next a pop-up window will open: 

 

 

If you see a field that you want in the report, Click that field from the “Universe” and drag it to the 
“Result Objects”.  Once the field is in the “Results Objects” it will appear in the Available Objects 
section on the main screen. 
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Researching FMMI User IDs 
 
Purpose 
This guide provides instructions to obtain the User Name associated with a User ID Number in FMMI. 
 
Role 
Funds Management Evaluator 
 
Instructions 
STEP 1: Go to Funds Management > Evaluation > Display FM Master Data > Display Fund Center 
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STEP 2: The following screen will display.  Enter a valid Funds Center (i.e., AP00000000), hit Enter. 
 

 
 
 
 
STEP 3: The following screen will display.  Click in the User Name Field, then click on the tab next to User name 
field. 
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STEP 4: The following screen will appear.  Enter the FMMI User ID number (i.e., F0003121) in the User field and 
click on Start Search. 
 

 
 
 
STEP 5: The following screen will display which provides you the User Name associated with the FMMI User 
Number. 
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Adjustments and Accruals 
 

Adjustment – For non-GL accountants in APHIS, adjustments are primarily used to recode the master data 
elements assigned to a particular financial transaction or group of transactions.  The following items are true for 
adjustments: 

• permanent 
• entered with two sides, one debit and one credit  
• there is no effect on cash; each adjustment balances to $0  
• can affect account balances, depending on which master data elements are changed  

 
Accrual – a place holder for a financial transaction or group of transactions which have not yet been posted to the 
financial system for the purpose of financial statement reporting.  The following items are true for accruals: 

• temporary, typically entered at the end of the month and reversed at the beginning of the next month 
• they are only entered with one side, a debit or a credit 
• affects cash like a normal financial transaction    
• do affect the balance of accounts 

 

Two Common Types of Adjustments 
• Expenditure Adjustments:  a process to move expenses from specific master data elements to other 

master data elements, such as BOC or WBS.   
• Collection Adjustments:  a process to move collections from specific master data elements to other 

master data elements.  (aka Transfers, Modifications) 
 

Two Common Types of Accruals 
• Expenditure Accrual:  a process to temporarily alter financial balances to account for a financial 

expenditure transaction or group of expenditure transactions which have not yet been posted to the 
financial system.   

• Revenue Accrual:  a process to temporarily alter financial balances to account for a financial revenue 
transaction or group of revenue transactions which have not yet been posted to the financial system.   
 

Rules for Adjustments 
• Adjustments should be made in the original system (WebTA, CONCUR) whenever possible. 
• Adjustments should only be made for posted transactions in FMMI, the official financial system.   
• Adjustments should include supporting documentation, which may include: 

o A written request from the field  
o Current reports showing error 
o Written explanation of the error, and/or 
o A copy of the original payment request showing the error being corrected 
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Who can Process Expenditure Adjustments in FMMI   
FMD wrote a policy on this which basically says that: 

• if the error was made by a financial team (mistyping etc.) or they are working on a specific clean-up 
project, the financial team can process the adjustment;  

• if the error was made by the field staff, the adjustment needs to be processed through the program 
headquarters.   
 

What should be a Debit or Credit 
• The USSGL Chart of Accounts shows the “normal” balance side of a GL account 

o http://fms.treas.gov/ussgl/index.html  
o ex. GL 6100- operating expenses - has a normal balance of a Debit.  This means that to reverse an 

expense is a Credit, and to post an expense is a Debit. 
 

 

Expenditure Adjustment Example    

FMMI B2 Example.xls

 
 

 
 

http://fms.treas.gov/ussgl/index.html
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Miscellaneous 

FMMI Dates Explained 
 
Below are the main dates in FMMI. The definition for each was taken from FMMI help. Their names do change 
based on which report or module you are in.  
 
Document Date ‐ The date the document was created.   

• This could be different from the posting date if an AR invoice is created and parked on one date but 
approved at a later date. 

• Date which appears in the document header and can be used for any defined purpose. 
• Can be defined by a person simply by entering any date.   
• For AP this is the Invoice Date.  
• For GL this is called Doc Date. 

 
Posting Date ‐ The date the document posts to the general ledger.   

• The date that determines the posting period and defines in which fiscal period a document posts to the 
General Ledger (regardless of the Document or Entry date). 

• When the document posts to FMMI. In the case of feeders or auto run processes, this run date can be 
defined by a person. Also, if a doc was in park or is super late the Posting Date could be in a future period. 

• Posting date must be in an open period, and that is why it is only seen later than Entry Date. You cannot 
back date posting date to a closed period unless you reopen that period. This should never happen. 

• OH runs based on this date. 
• GL Reports pull based on this date. 

 
Entry/Created Date – The date the accounting document is entered. 

• Entry date is not human defined, it is system defined. You do not see this on the data entry side of 
transactions. 

 
Clearing Date - The date the item is considered cleared.   

• When clearing, the last posting date of all the documents involved in clearing is set as the clearing date.   
• Clearing denotes all activities from the time a commitment is made for a transaction until it is settled. 
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Transparent Financial Descriptions 
 

• Answer who, what, where, when, and why (as needed) 
• Most people would understand what they mean, without having to pull the document 
• Are abbreviated to fit the allowable space, but still make sense.   

o Examples: 
 May 2014 Copier Maint – Boulder, CO 
 Adj- John Doe PP22- 10 Hours 
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Helpful Links/Resources 
 (Ctrl+ left click on the links below) 

 
• APHIS Homepage 

www.aphis.usda.gov  
 

• FMD Website 
APHIS Homepage  Our Focus  Business Services  Financial Management 

o Travel Service Center (portal log-in required) 
Financial Management > Travel Services Center (Employees Only) 

o FOST 
Financial Management > Financial Operations Services Team 

o Agreement Services Center FAQs 
Financial Management > Financial Services Branch > Agreements Services Center > 
Frequently Asked Questions 
 

• Financial Management Modernization Initiative (FMMI) 
APHIS Homepage > Our Focus > Business Services > Application Systems > Financial Management 
Modernization Initiative (FMMI) 
 

• BOC Handbook 
https://nfc.usda.gov/FSS/Publications/FMS/boc.pdf 
 

• Federal Account Symbols and Titles (FAST Book) 
http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm 

 
• US Standard General Ledger (USSGL) 

https://tfm.fiscal.treasury.gov/v1/supplements/ussgl.html 
 

• Concur: 
https://cge.concursolutions.com/ui/sso/usda 
 

• GSA Travel Resources 
http://www.gsa.gov/portal/content/105307 
 

• GSA Forms Library 
http://www.gsa.gov/portal/forms/type/TOP 
 

• OPM Forms Library 
http://www.opm.gov/forms/ 
 

• My APHIS:   
my.aphis.usda.gov/myportal/myaphis/employeeresources/forms-and-publications/bam 
 

https://www.aphis.usda.gov/aphis/home/
https://www.aphis.usda.gov/aphis/ourfocus/business-services/financial-management-division
https://my.aphis.usda.gov/wps/myportal/myaphis/support/travel/
https://www.aphis.usda.gov/aphis/ourfocus/business-services/financial-management-division/financial-operations-branch/FOST
https://www.aphis.usda.gov/aphis/ourfocus/business-services/financial-management-division/Financial_Services_Branch/Agreements_Service_Center
https://portal.fms.usda.gov/
https://nfc.usda.gov/FSS/Publications/FMS/boc.pdf
http://www.fiscal.treasury.gov/fsreports/ref/fastBook/fastbook_home.htm
https://tfm.fiscal.treasury.gov/v1/supplements/ussgl.html
https://cge.concursolutions.com/wait.asp?u=gWrzeByoGLxM$p1z5d0Sis6pTtW2M32rvhv8XjLZiC23nlIfM4gVbH6TOiPj7EvRWLx5TZSukGU2Ikyk4oGDy$s$p1RdthvZcxFR1YbuJQ&sh=2
http://www.gsa.gov/portal/content/105307
http://www.gsa.gov/portal/forms/type/TOP
http://www.opm.gov/forms/
https://my.aphis.usda.gov/myportal/myaphis/employeeresources/forms-and-publications/bam


  

Page 196 of 216 
 

• USDA Washington Metro Area Telephone Directory 
https://www.datarefuge.org/en_AU/dataset/usda-telephone-directory 
 

• Internet Search Engines:   
o www.google.com 
o www.yahoo.com 
o www.bing.com 
o www.ask.com 

 
• APHIS Budget and Accounting Manual (BAM) (portal log-in required)  

 http://inside.aphis.usda.gov/mrpbs/publications/accounting_manual/accounting_manual.shtml 
 

Discussion:  Questions/Concerns from Field Staff 

5th bill (final bill) 
o It is a standard business practice to bill based on expenses entered.  This is how FMMI 

(SAP) works.  This is also how businesses bill (i.e. credit card bill, etc).   
o Accruals are the only way to account for expenses which are not yet entered and they are 

not billable.  Keeping track of your planned expenses (accruals) may assist you in 
predicting what expenses are still outstanding, but will not eliminate the 5th bill.   

o There will always be a 5th bill on quarterly billed accounts unless you cut off service the 
last month or so to ensure they make it on the 4th quarter bill.  One way that may make 
this more palatable is to make these accounts monthly.   

ACMS 
o Most FMD staff members located in Minneapolis do not use ACMS, we use FMMI.  Our 

understanding is that APHIS uses ACMS for program accruals, budget, and agreement 
tracking.   

o Questions will need to be referred to the appropriate FMD Riverdale staff.  Refer to the 
below screenshot for appropriate ACMS contact information.   

 

https://www.datarefuge.org/en_AU/dataset/usda-telephone-directory
http://www.google.com/
http://www.yahoo.com/
http://www.bing.com/
http://www.ask.com/
https://my.aphis.usda.gov/myportal/myaphis/employeeresources/forms-and-publications/bam
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Appendix A- FMMI Doc Types 
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Appendix B - Reallocation Process 
 
US Bank Access Online is designed to only allow cardholders one chance to modify the accounting code and/or 
budget object code (BOC).  Once the transaction is reallocated to modify the accounting code and/or budget 
object code (BOC), and included in a GL extract, it is locked from further changes. 
 
Reallocated transactions (ZS documents) will not be fed to the interface systems to post in the Financial 
Management Modernization Initiative (FMMI) when the cardholder fails to properly validate the BOC.   
 
When reallocating, the cardholder must click on the magnifying glass next to the BOC field to search for a valid 
value to validate the code. 
 

 

 
 
Listed below are some examples of reallocated transactions with either missing BOC or contain invalid BOC.  This 
resulted from the cardholder failing to properly validate the BOC. 
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How do you know if a transaction is locked? 
You can check the Allocations or Comments Tab for the transaction status.  If the transaction is locked, a message 
“has been included in a GL Extract” will populate in one of these two tabs. 
 
The GL extract will populate usually the next business day after the transaction is reallocated. 
 

 
 
The pad lock symbol does not truly indicate that the transaction is locked.  It will populate as soon as the 
transaction is approved. 
 

The  symbol will populate as soon as the accounting information is changed. 
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How can the accounting information be changed if the transaction has already been included in GL extract? 
The cardholder needs to report the transaction to the budget analyst to determine if the accounting adjustment 
can be done in FMMI. 
 
Transaction Availability 
If the transaction has not been included in a GL extract, it can be modified to change the accounting code, BOC, 
and item descriptions.   
 
The GL extraction will not occur if the accounting code and/or BOC have not been changed when the cardholder 
initially approved the transaction.  The transaction is then available for modifications up to six billing cycles (180 
days). 
 
How to reallocate a transaction that has already been “Approved”? 
If the transaction is available for modifications, the cardholder needs to follow the steps below to edit the 
transaction. 
 

1. First select the transaction and click on “Pull Back” button.   
2. Once the transaction has been pulled back, click on the Accounting Code link.  The Allocations tab will 

open. 
3. Click on the “Magnifying Glass” next to the Line of Accounting to search for a valid value. 
4. Once the accounting information is updated, click on Save Allocations button to save changes. 
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How to reallocate a transaction that has already been “Final Approved”? 
If the transaction is available for modifications, the Cardholder and Approving Official need to take the following 
steps to edit the transaction.   
 
STEP 1:   Approving Official will: 

a. Log into Access Online, click on Manager Approval History, select the transaction, and click on Pull Back 
button to pull it back from history. 

b. Click on Manager Approval Queue, select the transaction, and click on Reject button to reject it to the 
Cardholder. 

 
STEP 2:  Cardholder will: 

a. Once the transaction has been rejected, the Cardholder will log into Access Online and navigate to the 
Transaction List. 

b. Click on the Accounting Code link next to the transaction in question.  The Allocations Tab will open. 
c. Click on the Magnifying Glass next to the Line of Accounting to search for a Valid Value.  Select the code. 
d. Click on Save Allocations to save changes. 
e. Approve and forward the transaction to your Approving Official for approval. 
f. Notify the AO that the transaction is pending for his or her approval.  Note:  The final approval shall be 

done quickly to avoid receiving a pre-suspension notice, especially before the transaction is dropped from 
the system. 
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Appendix C - BI Reporting  (applies to BI Reports) 
 

Save Layout 
 
Saving layouts allow users to run their typical reports without having to reconfigure the final format of the report 
each time.  Simply create/modify the format you would like your report to display as and click on Save As.  Users 
can make changes to the layouts and/or resave the layouts after running the reports.   
 
Layouts saved with a “/” before the name are public layouts (i.e. /WS xxxx).  Layouts without a “/” before the 
name are private layouts (i.e. WS xxxx). 
 

 

 

Open/Select Layout 
 
Opening/selecting a layout allows users to run their typical reports without having to reconfigure the final format 
each time.  Simply select the layout you wish to use.  This will re-populate the screen with the pre-defined layout.  
Users can make changes to the layouts and/or resave the layouts after running the report.   
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General 
 
BI reports are highly customizable to limit or expand the data you wish to see, options include: 

• All of the General Tips and Tricks above, plus… 
• Drag and Drop 
• Filter 

o Filter  
o Variable Screen (brings you back to the variable entry screen) 

• Settings 
o Conditions (can find specific dollar amount – add > threshold) 
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Subtotals 
 
Users can either bring in subtotals or remove subtotals.  Simply right click on the field you would like to add or 
remove subtotals to or from, click on Properties, Characteristics, and under the General tab change Display 
Results from “always” to “never” or vice versa.  Users must have two or more characteristics in the report for this 
to work.   
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Appendix D: Remittance Advice Instructions
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Print Any File to PDF 
 

Open any document you would like to save as a PDF file, for example an email or an internet page.   

 

Move your curser to the top left corner and select File --> Print as shown below.  
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Then you will be prompted with a screen that looks like this:  

 

 

After you click on Print, you should be prompted with a screen similar to this: 
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Once the PDF is created, it will look similar to this (depending on your version of Adobe Acrobat):  
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FMMI Frequently Used Icons 
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WS SO Cheat Sheet 
(Bullet items are required field inputs) 

SO Details   Display SO, Line Items, Doc Flow  
• SO Number or WBS Element 

 

SO Progress   Reimbursable Order Report (/ZWSLAYOUT) 
• Fund, Fund Center, and WBS Element 

 

Billed Expenses Details  Line Items – Actual Costs/Revenue Report (1_USDA_RRB2) 
• WBS Element and Posting Date Range 

 

Billed Expenses Exceptions DP-98 File 
 
Bills    View a Billing Document or SO Doc Flow 

• Billing Doc Number  or  SO Number or WBS Element 
 

Collections   Daily Collections Report 
• Funded Program (WBS) or Customer Number 

 

Budget Full   Budget Availability Control - AVC Tables  
• 9H and Funded Program (WBS) 

 

Budget Less Indirect Expenses Budget Availability Control - AVC Tables 
• ZR and Funded Program (WBS) 

 

Budget Availability Only SOF PTD (/WS RMVD 4610YE) 
• Fund and Fund Center 

 

OH Reconciliation  Line Items – Actual Costs/Revenue Report (/WS OH RECON) 
• WBS Element and Posting Date Range 

 

OH Charged   Line Items – Actual Costs/Revenue Report (/WS OH CHRGD) 
• WBS Element and Cost Element 6100980000 and Posting Date Range 

 

OH Split   Line Items – Actual Costs/Revenue Report (/WS OH SPLIT) 
• WBS Elements (up to 4 per 1 account) 
• Cost Element 6100980000 
• Posting Date Range 

 

OH Earned   Line Items – Actual Costs/Revenue Report (/WS OH SPLIT) 
• WBS Element and Cost Element 6100980000 

 

OH Spent   Line Items – Actual Costs/Revenue Report (/WS OH SPENT) 
• WBS Element 

 

OH Avail   Line Items – Actual Costs/Revenue Report (/WS OH AVAIL) 
• WBS Element 

*Use in combination with SOF PTD.  LIACR does not capture commitments or obligations.   
 

Customer Acct Details  Customer Line Item Display (/WS UNCLEARD) 
• Customer Number 
• Status = All Items 
• Type = check all boxes 
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